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You are here: Polaris Leap Overview > Signing in to Polaris Leap
Signing in to Polaris Leap

When you sign in to Leap the first time, you enter your domain, user name, and password. Another dialog box
opens where you select your branch and workstation. After signing in the first time, you only need to enter your
domain, username and password; your branch and workstation are selected automatically.

Important:
Your username cannot contain spaces.

To sign in to Polaris Leap:

1. Using your favourite web browser, visit:
onsite https://leap.tracpac.ab.ca offsite https://lleap.tracpac.ab.ca/LeapWebAppExternal

*offsite access requires permission from Marigold by contacting support@marigold.ab.ca

The sign in page opens.

2. Enter MLSCAL\yourpolarisusername in the Domain\Username
box.

3. Enter your Polaris password in the Password box.

4. Select SIGN IN.

Another page opens where you select your branch and workstation.

Anrch

Werkatatos

5. Select your branch in the Branch drop-down list box.
6. Select Leap workstation in the Workstation drop-down list box.

7. Select CONTINUE.
The Circulation page opens with the cursor in the quick search box in the page

header.


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Polaris_Leap_Overview.htm

& CHECK 1 & HEW PATRON

Notes:

ol
If RFID has been enabled for Leap, the RFID indicator appears on the search button .
If you are using Leap on an iPad or another tablet, the PRINT button does not appear.

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.



You are here: Polaris Leap Overview > Leap User Interface
Leap User Interface

This section describes the general user interface (Ul) elements that are available throughout Leap in the
application's header and workforms.

Note:
The procedures in the Leap documentation use click as the action (click with the mouse button),
but if you are using a touch screen, the action is tap (tap on the screen).

Leap Header

The Leap header appears when you log into Leap and remains visible throughout the application.

& CHECK IN L HEW PATRON = PRINT

The Leap header includes:

« Workforms Tracker
« Quick Search Box
» Find Tool

*« New Menu

« Utilities Menu

« Help Menu

* User Menu


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Polaris_Leap_Overview.htm

Workforms Tracker

To open the Workforms tracker, click the slide-out (hamburger) Ebutton.

The Workforms tracker displays the open workforms. You can pin the Workforms tracker by selecting the
pushpin icon, filter the list by typing in the Filter Workforms box, or close all the workforms by selecting CLOSE
ALL. When you log out of Leap and then sign back in, the tracker remains in the same position (pinned or
unpinned) as in your previous session.

Note:
The pushpin icon may not appear when viewing Leap on a narrow screen or window.

13210 zip code

Mr. George P
Anderson

Masir Aziz
Ms. Laura Izquierda
Adrianne Rose Leonne

Anar Kamat

Letters from the park.
[videorecording]

CLOSE ALL

Quick Search Box

When you sign in to the Leap application, the cursor appears in the quick search box where you can scan a

patron or item barcode, or enter search criteria to find bibliographic or patron records.
6



I':':,_':' or search Q;h
If RFID has been enabled for the workstation, the search button includes an RFID icon.
Find Tool

When you click “ in the Leap header, the Find Tool opens where you can search for records and record
sets.

New Menu

The New menu includes options for creating a new patron record or record set.

- helll; ) ‘

Patron Record
Record Set

Utilities Menu

The Utilities menu includes options for opening the Holds Queue or Picklist, and options to create unlinked
bibliographic or authority record sets.

— UI:IIII o

Holds Quewse

Picklist Processing
Create Unlinked Bibliographic Record Set

Create Unlinked Authorty Record Sst

Help Menu

Click Help to open the Help menu, and click Leap Topics to open Leap online Help, Keyboard to open a list of
keyboard shortcuts, or About to open the About Leap window.

HE'P ’

Leap Topics
Keyboard
About


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Find%20Tool.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Hold_Requests.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Holdspicklist.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/RecSetUnlinkedRecs.htm

Leap Online Help

To access the Leap online Help, select Help | Leap Topics. The Leap online Help includes Contents tab, an
Index tab, a search box, a highlight button, and a print button.

@ polaris
[=F-Ta]

u] Contants

Index

+ Polaris Laap (varview
+ Saming Laap Options in P Adminisialio
+ Micadilying Fear Setlings

+ Liging the Fiesd Tool

Keyboard Shortcuts

To access the list of keyboard shortcuts for performing actions or going to specific views, select Help |
Keyboard.

Keyboard Shortcuts

ACTIONS Patron Views

MNew Patron ¥ Check Ouwt 1

Check In / Out/Overdue 2

Filter f Account 3

Complete Checkout Claims/Lost 4
Holds/Heald 5
Motes L

Reading History

Associations &
MNotices 9
Registration

CLOSE

About Leap

To access the About Leap window that contains information about the Leap application, select Help | About.
The About Leap window contains information about the Leap application including the client JavaScript and API
versions.



About Leap

Polaris Leap VWeb Application v5.6.105.0 (Client JavaScript: 5.6.0.0 (dev) AP 5.6.105)
2017 Innovative IMerfaces Inc

Application Seltings
wriRoot:
ERMSNetworkAddress
VETSEN:
language:
arganizationld:
workstationkd:
lncalelama:

User |dentity

CLOSE

User Menu

Select your username in the upper-right corner of the Leap header to see the options: Settings, Clear Cache,
and Logout.

I usemame (COE)~

Settings

Clear Cache

Logout

Leap Workforms

Records, record sets, user settings, and lists (such as the Picklist and Holds Queue) are displayed in workforms
(web pages) where you can add data, sort lists, change data, and perform actions (depending on the record
type and your permissions). Workforms contain header data that identify the record or record set, and multiple
tabbed views that contain different fields.

Leap workforms include some or all of the following menus, views, and elements:

« Actions Menus
« Refresh Button
« Results Button
» Options Menus
* More Menus

« Navigation Menus
+ View Bars

« Button Toolbars
« Required Fields
» Check Boxes

« Action Buttons


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/User_Settings.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/SAsetcach.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Open_a_Patron__Item__or_.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/RecordSetsGeneral.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/User_Settings.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Holdspicklist.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Hold_Requests.htm

« Plus Buttons

* Drop-Down Lists

« Date Fields

+« Message Boxes

e Summary Bars

o List Views

« Filters

« Links to Other Records

ACTIONS Menus

The ACTIONS menu appears on workforms where you can initiate a process or modify a record. It may appear
in a workform header or above a list view.

When you click an ACTION button in a workform header, the drop-down list opens with actions available for the
record as a whole.

i Bibliographic Record Set @

Hame Cramenr

+& Create sanhaonty Recond Set

B Dekte Recond Set

ACTION menus in list views are activated only when one or more entries are selected in the list. You first select
the entries to which you want to apply the action, then select the appropriate action from the drop-down list.

I.E] Eihlingraphic Record Set 'ﬂ' ACTIONS = " REFRESH m

Mame Dwymer Record Set 10

e FIND TOOL [] Awe-RFID ACTIOMS =
£ A3 o New Record Sel
LINKED
TITLE ALITHOR FORMAT ITEMS HOW DS
& Fridays with tha wizams Saaige, Jessica Day Blosk
1576
REFRESH Button
. C REFRESH |,
You can click in a workform header to see recent updates to the record or record set.

RESULTS Button

If you have opened a record from the Find Tool results, you can click WRESULTS | 44 return to the Find Tool

results list. If the workform is displayed in a narrow view or window, only the icon appears on the button.

Options Menus
10



Options menus provide selections for additional functions, such as the column and filter options for the Find

Tool.
Q&

Column Settings

Search Filter >

More Menus

Some record views contain a More menu that contains additional views and options. Select the down arrow next
to More to display the list.

& Check Out (0)  §M Out (6)/ Overdue (5) B9 Account ($3.50) & Claims (1)/ Lost (0) M Holds (6) More *

4 Reading History
I, Associations

B4 Motices
L
W Kessages
o Blocks
s Notes

Find Toal © Special Login

‘_lh

O earcobe CALL NUMEER TITLE DUE DATE ACTION SHELF LOCATION ASSIGNED ERANCH

Navigation Menus

You can move through a patron record in Leap by selecting an option in the left navigation menu.

A Profile
. Preferences [ e ]
L Aftributes
§ RENEW
EA Email Exclude from Nofices and Reminders Language
# Address English w
O overdue [+
. Phone/Fax COPY
[ Hold W1 Maintain Reading History
A Nofifications [ Billing [ Do Not Delete Record
Almost Overdue/Auto-Renew [ E-mail Motices in Plain Text DELETE
%, Password Patron Record Expiration [ Exclude from Collection Agency
7 "
&image Inactive Patron
@ Misc. Info
View Bars

View bars provide tabs for different views of a workform. Some tabs include summary information, such as the
number of items checked out and overdue for a patron record. The tab for the active view appears in blue.

& Check Out (0) I Out (2) / Overdue |j2jzf B9 Account (30.00)  © Claims (0)/Lost (0) ™ Holds (4) More *

Button Toolbars

Button toolbars appear at the top of lists, such as the list of items out, and contain buttons for performing actions
on items in the list.

11



@ Special Renew 4 Reset Due Date E Estimate Fines

(2 Make A Claim

More ~ ]

TYPE DUEON ¥

BARCODE

TITLE

AUTHOR

Filter ltemns

BRANCH

& Print List -

Required Fields

Fields marked with an asterisk are required.

Barcodekl

Check Boxes

Some check boxes are used to apply an option, such as maintaining a reading list for a patron.

Preferences
: L
(0) Exclude from Collection anguage
Agency English

() Exclude from Overdue
Notice Maintain Reading List

() Exclude f Hald Notic .
i Exelude fram e ) Do Not Delete Record

(L] Exclude from Billing

) E-mail notices in plain text

Other check boxes are used to choose a line or lines in a list view and then apply the same function to the
selected lines.

For example, choose the check box next to a hold in the Picklist and select Located. When you choose an entry
or entries in the list, the action buttons become brighter if the action can be performed on the selected entries.

Picklist Stilwater Publkc Libra (™ REFRESH m
W Pendi B Located T Unciaimed (25) = virmed ILL (1 W Hakds o Transie
Total ilems | 5 tolal
o SHELF CALL MATEFR1AL PICKUP PENDNMG
| J COLLECTION  LOCATION HUMEER AUTHOR TITLE TYPE BRARCH BARCODE DATE
[F] At Fiction Fataman Private  #1 Bk KMC RS SHB0NT
Jarees, 1047- suspect | & novel
[4] W Chidrens jFic W Jong The hoisa of siety ook SAR BA2016
= Eictien Meindart. 1510-  Tathers

To check all the boxes in a list view, select (check) the box in the list header.

Command Buttons

Buttoq?, such as m are used to perform an action.



Plus Buttons

Buttons labeled with a plus sign, such as | _©APPRESS | oypand the area on the page so you can enter
information.

Address Type City
Home o COBLESER
Posial Code Ziprad State
12043 M
Straet Address County
SCHOHARIE
Street Address Ling 2 Country
|
E DELETE

Drop-Down Lists

Select an entry in a drop-down list box You can type the first letter of the entry to quickly go to that portion of a
list.

Date Fields

When you click or tap inside a date field, a calendar control appears.

12/8/2P16

@ Dec *|2016 ~*| O

Su Mo Tu We Th Fr Sa

11 12| 13 14 15| 16| 17
18( 19 20| 21| 22 23| 24

25| 26| 27| 28( 29( 30| 31

To locate and choose a date, do the following:

« Select the date in the current month.

Select the left arrow to go to the previous month.

Select the right arrow to go to the next month.

Select the month at the top of the calendar to open the month list, and choose the month.

Select the year at the top of the calendar to open the year list, and choose the year.

Message Boxes

13



Green message boxes appear when an action was successful, and red message boxes appear when there is a
problem with an action or a blocking condition prevents the action from occurring. In most cases, messages in
Leap appear according to the same conditions under which messages appear in the Polaris ILS.

T RGO Tee TomwAT momoon | oAn = SIAIGS | DRAmOIT | WOLOL | Omiie | Gnoor

O Daley, LUEEERIE  Hold request(s) have been created, munity 1
Robert. the true sto ry

Summary Bars

A summary bar displays at the top of list views, such as the Charges view and the Claims view.

((charges: 5000 Deposits: 3000 Credits: 50.00 Balance: $0.00 View: Account Summary *

O TvPe DATE  BARCODE TITLE REASON ORGANIZATION NOTE Collection Agency

Transaction Summary

List Views

In list views, such as a list of the items the patron has checked out, the line items are displayed in rows with
sortable column headers. To sort the line items, choose a column header. To perform actions on a line item,
choose the check box. If you choose the check box in the header, the check boxes are selected for all lines.
When multiple lines are selected, the buttons are activated for the actions that are possible for all the selected
lines.

<& Check Out (0) i1 Oul (2)/ Overdue (1) B Account (50.00) @ Claims (0)/Lost (0) ™ Holds (4) More
LRV © Special Renew #Reset DueDate  [f Estimate Fines (@ Make A Claim Wore + ]
RENEWALS
TYPE DUECHN v BARCODE TITLE AUTHOR LEFT CALLNO. BRANCH
i) A 10162014 0000410138414 The *aar of ving dangerously [DVD] Oof0 DVD Fict Yea Schenectady Branch
Video -Ce..
E (8] 72312015 0001000035103 One hundred yesrs of solitude Garcia Oof§ Fict Gar Canajoharie Library
k=4 Ty Mérquez,

Some list views, such as the Holds list view, have filters which will filter the list as you type. The filter works on
any data column. For example, if you start typing a number and a call number begins with that number, the list
will show only those line items with call numbers that match the filter entry.

CALL ACTIVATION PICKUP
AUTHOR TITLE FORMAT NUMBER A STATUS | BRANCH QUEUE HOLD UNTIL GROUP
Kolter, Jane | Forgetmenot:a Book 746.46 Kol | Tuesday, Pending | Community 1 Tuesday,
Bentley. gallery of friendship November 26, Library December 31,
and album quilts 2013 2013

Links to Other Records

To go from a record to another linked record or to an associated list view, select the LINKS button, or select a
blue text link.

14



Itern Record ©

Euphoria : a nowvel

Eiy Hing Liy, asthar

Harcoda 12231954838 L Man-cimulating elonient & Display in PG

Call rasmsbsar Ao wtaie Final [Frms

Cotiection: Aduh Fiction Bk '.|.n||:|||u| ik ndred b

Shet kncation Mo Parasi am Pricac $16.50

{hming branch: Comessnity Library Bsaigned Branch Comimuniy Librany Eitdnhnsm.s Ot || TR 1:85:36
]

B Detail ulaticn sk Bocks and Moles @ Hislory B Shalistes More =
Tuse date: 12216 115958 PM et beeg_ 1229195403658 Check-sut date 128016 145 36 PM
Faataraiaks laban 0 Lisaning bear Comsiunily Lilwary Oigginal dus date: 12232016 1:58.55% PM
| — £ i T
F A T - ¥
Las! boation In-trans it Tearndened
Teeck-in at: Community Library :
in date; 22008 10:23 34 AW TSRy Library
HRAG 145 36 FM
Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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You are here: Polaris Leap Overview > Printing Workforms
Printing Leap Workforms

The Print function works in the following browsers:
« Windows IE 11

¢« Windows Chrome 45
¢ OS X Chrome

Due to iOS limitations, the PRINT button does not appear if you are using Leap on an iPad.

When you select the PRINT button, the entire view is printed, including all entries in a list view.

creativity

—_— S PRINT

ANAR KAMAT o 4L REGISTRATION C' REFRESH
ol
@ BLOCKS [ NOTES
o Check Out (0) M Out (3)/ Overdue (3)  Ev Account ($2.40) @ Claims (0)/Lost(0) ™ Holds (4)
E Estimate Fines More =
RENEWALS
O Tvee DUEON ¥  BARCODE TITLE AUTHOR LEFT CALL NO.
O -;'ﬁ; 0000401367461  Gone girl. [sound recording] Cash, 0of0 RDF
Music ~ 7/28/2015 Johnny. C33go
O L 9/8/2015 0001900128818 The low-maintenance house Logsdon, 20of3 643.7 Log
Book Gene.
O L 9/8/2015 0001900042910  The new diary : how to use a jounal Rainer, 20f3 150.13 R15
Book for self-guidance and expanded Tristine.

- I

More *

BRANCH

Schenectady
Branch - Ce...

Community
Library

Community
Library

Polaris Version 5.6

16

© 2017 Innovative Interfaces, Inc.


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Polaris_Leap_Overview.htm

You are here: Polaris Leap Overview > Setting Up Receipt Printing for Leap

Setting Up Receipt Printing for Leap

Printing receipts from Leap depends on the options set for your library organization in Polaris Administration, the
device you are using to access Leap, the workform settings in the Polaris ILS, the Print Options user settings in
Leap, and the receipt printer configuration. When the receipt printer has been configured, and the workform print
options are set to print a receipt for an action, the Printer Options or Print dialog box opens automatically when

the user performs the action.

Printer Options box for an iPad

Printer Options

Printer

1 Copy

Print box for Windows

0 Print

General | Options

Select Printer

Adnhe PDF Fax
<

Status Ready
Location Syracuse, New York
Commert Product Development

Page Range

Selection Curent Page
() Pages: 1 | Collate

Enter either a single page number or a single
page range. Forexample, 5-12

@Al Number of copies

G

Receipts and slips are printed from Leap according to the settings in Polaris Administration and workform print
options, which can be set in the Polaris staff client or in Leap. You can also re-print receipts. For Leap print
settings, see Set User Print Options for Receipts and Slips. For information on setting workform print options in

the Polaris ILS staff client, see the Polaris online Help.

See also:

Receipt Printer Configuration

Polaris Version 5.6

© 2017 Innovative Interfaces, Inc.
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https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Polaris_Leap_Overview.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Set_user_print_options_i.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Set_user_print_options_i.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Receipt_Printer_Configuration.htm

You are here: Polaris Leap Overview > Receipt Printing from Leap > Receipt Printer Configuration
Receipt Printer Configuration

Before you can print receipts from Polaris Leap, the receipt printer must be configured correctly. To set up
receipt printing, configure the receipt printer, verify that the page size is available, create a custom paper size if
the page size is not available, and set up the page in the browser. The table below shows the receipt printers
that were tested with Leap using the operating systems, drivers, and browsers indicated.

Receipt Printer Windows 7 Windows 8.1 Mac OS
Xv10
Driver: Star TSP600 Star 3.0
Star TSP600 Cutter (TSP643) f(E)rrRIAE;rC
Chrome, IE10, IE11
Chrome,
Safari
EPSON TM-T88IV
Epson TM-T88IV ReceiptE4
Chrome, IE10, IE11 Chrome, IE11
Star TSP700 Star TSP700
(TSP743)
Chrome, IE11
See also:

» Configure a Receipt Printer for IE10 or IE 11 on Windows 7 or 8.1
« Configure a Receipt Printer for Chrome on Windows 7 or 8.1
« Configure a Receipt Printer for Chrome and Safari on Mac OS X

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Polaris_Leap_Overview.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Receipt_Printing_from_Le.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Configure_a_receipt_prin.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Configure_a_receipt_prin1.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Configure_a_receipt_prin2.htm

You are here: Modifying User Settings > Set User Print Options for Receipts and Slips
Set User Print Options for Receipts and Slips

If your library has a license for INN-Reach integration with Polaris, you can select the INN-Reach print options.
To set the options for printing receipts and slips in Leap:

1. Select your user ID in the upper right corner of the page.
2. Select Settings.

The Settings page opens with the Print Options view displayed.

Settings C REFRESH

= o [ B
t 1 ut -
F ceipl # Chack © ket 2 ci . "
y I Fo o ciolp only i o aFlecs] Flacept
I il sbf e .
Hiokds cnl anly if ng aReosp . -
Hald =lip Tane . -
Huld all & Hudke ik "
Huold pick Hoidl =lip Hal I
INN-Figa K I il call sl Hald call sk
Hold plclop 5k Haid pickup sy
MH-Fa Slip 84 Reach Pickup Sk
Hi 251! i
I by i . e -
o o fosl nly Hacept
Prim L Pighig 51 Hdd call 51 ansit sl
Hold plckup slip Huolds onk
MH-Raach 1l :

3. Select the receipts and/or slips to print.

Important:
Configure the receipt printers to print receipts and slips from Leap.

4. To prevent check out receipts from being printed when the patron has selected eReceipts as their
notification method, select the only if no eReceipt check box.

5. Click SAVE.

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/User_Settings.htm
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You are here: Records and Record Sets Displayed in Leap Workforms > Patron Record
Patron Record

The Patron Record workform in Leap includes header information and two main views: one contains the
patron's registration information, and the other contains information about the patron's library account.

Patron Record Workform Header

The Patron Record workform header includes: the patron's name, barcode, and the branch where the
patron is registered; an information icon; links to BLOCKS and NOTES views; a REGISTRATION button
you can click to go to the patron's registration information; an ACTIONS button and menu; and REFRESH
and CLOSE buttons.

You can click € to open the PATRON INFO pop-up window that displays the patron code, home address,
phone number, email address, registration expiration date, and notification preference. Additional user-
defined fields (UDFs) appear in this box if they are selected for display in the patron services parameter
Check-out: Optional patron data. The following additional fields do not appear in this box even if the
parameter is set to display them: eReceipt option, Address check date, Birthdate, Last activity date, Phone
2, Phone 3, Registered branch, and Statistical class.

MASIR AZIZ O

A summary bar displays the number of items out and overdue; the account balance; the number of lost
and claimed items; the number of hold requests and held items; and the number of ILL requests and held
ILL items.

You can click More to open a menu and go to one of the following views:

Note:
The More menu includes the ILL view if the Patron Record workform is displayed in a
narrower window.

» Reading History

» Associations

» Notices

» Messages

» Blocks

» Notes

« Record Sets
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The cursor is in the Check out an item box, where you can scan an item barcode to check out the item to
the patron.

MAS'R ﬁZII ﬂ' ]_HEG-IE-TRATIDN ACTIONS - C'HEFHEEH m
_EE; B BLOCHS
& ok Ot L Tall g wnrcse (1) I Acooun [§ 3 Clairs ot - ks Held (1 HILL Hikd e
-
o

Patron Record - Registration Information

To create a new patron record, click the NEW PATRON button or select New | Patron record. The Patron
Registration view of the patron's record appears.

This view also appears when you click the REGISTRATION button on an existing patron's record. Use the
navigation menu along the left of the workform to move to specific sections of the patron's registration
information.

From this view, you can update the patron's registration information, renew a patron's registration, copy
registration information to another patron's record, merge the patron record with another patron record,
secure (or release) the patron record, or delete the patron record.

MASIR AZIZ © 1 RECISTRATION ACTIONS - o
@ B BLOCKS
o G n 1 -
b profle TN
y—
R Bancide * Segisianad AL RENEW
A &
. . Eapy
A 123121231 Regdal . WMERGE
% DELETE
By Passiw
- Al

SECLRE
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Patron Record - Library Account Information

When you open an existing patron record, the Check Out view appears where you can check out items to
the patron. To go to other views, click one of these tabs: Out/Overdue, Account, Claims/Lost, Holds/Held,
or ILL/Held.

Note:
The ILL/Held option may be under the More menu if you are viewing Leap in a narrower
window or screen.

Or, from the More menu, select: Reading History, Associations, Notices, Messages, Blocks, or Notes.

Patron Record - Record Sets View

To see the record sets to which the patron record belongs, select More | Record Sets. You can click on a
record set in the list to open the Patron Record Set workform.

NASIR AZIZ ﬂ 4 REGISTRATION ACTIONS ~ [
ﬁi' B BLOCKS
1
& Check Out B Cut (1) 7 Owerdue (1) & Account (3000 & Claims (0) 7 Last (0 ™ Haolds (317 Held (1 @ Record Sets =
TOTAL CREATION
HAME DWHNER RECORDS DATE HOTE
13210 zip code Community Library 13
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You are here: Creating, Modifying, and Deleting Patron Records > View, Edit, or Renew an Existing

Patron’s Registration

View, Edit, or Renew an Existing Patron’s Registration

To view or edit an existing patron’s registration information or renew the patron’s registration:

1. Scan a patron’s barcode or search for the patron.

The Patron record appears.

2. Click REGISTRATION.

The Patron record | Registration view appears.

3. To go to different sections of the patron record, select an item from the left navigation menu.

4. To edit the patron’s registration information, type the text or select options, and click SAVE. See

Register a New Patron for information on the registration fields.

5. To renew the patron’s registration, click RENEW to open the Renew Registration box.

Renew Registration

Expiration Date

51572015

Address Check Date

5/M5/2016

Alexandria Lee Remey's registration expired on 5/15/2015. Would you like to renew the regisiration?

Ezxpiration Term
3 [v] Years  [v]
Address Check Term

1 [v] Years V]

CONTINUE CANCEL

6. To specify the renewal expiration and address check date, you can enter a length of time or an

exact date:

e Enter a number and select Years or Months.

« Select Exact Date, and select a date from the calendar.

Polaris Version 5.6
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You are here: Creating, Modifying, and Deleting Patron Records > Register a New Patron
Register a New Patron

To register a new patron:

Tip:
You an also copy a patron record to register a new patron.

. Select New | Patron Record or click the NEW PATRON button.

m

The Patron Registration page appears with the Profile view selected.

Tips:

Required fields are marked with an asterisk.

You can use the vertical scroll bar to scroll through the sections of the Patron Registration
page.

Or, to quickly go to a section of page, select an option in the left navigation bar.

Patron Registration 1
A Affributes:
= Email Barcode * Registered At * CANCEL
e | Community Library v
* Phone/Fax Former Barcode Patron Code *
A Nofifications Regular v
# Preferences
Last Name * Date of Registration
A Password J—
[£a] Image
First Mame * Expiration Date *
ST2018
Middle Name Birth Dafe
Title Suffix Statistical Class
{None) [~ {Hone) |
Gender *
O mae O Female @ nia

2. In the Profiles section, enter the following information:

a. Scan the patron's barcode in the Barcode box, or type the barcode.

Note:
If the patron was registered previously and had a library card with a barcode, enter the

old barcode number in the Former barcode box.
b. Type the patron’s last name (at least one character) in the Last name box.

Tip:

Do not use spaces when typing compound last names. For example, type MacDonald
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(instead of Mac Donald).

c. Type the first name in the First Name box

d. Type the middle name in the Middle Name box.

e. Select the patron’s title in the Title box.

f. Type the patron’s suffix (such as Sr., Jr., Il, or Ph.D.) in the Suffix box.
g. Select the patron’s registration branch in the Registered At box.

h. Select the patron’s code in the Patron Code box.

i. Click/tap in the Expiration Date box to open a calendar, and select the date that the patron’s
registration will expire.

j- Click/tap in the Birth Date box to open a calendar, and select the patron’s birth date.
k. Select a statistical class for the patron.
|. Select Male, Female, or N/A under Gender.

3. Select Attributes in the navigation bar to go to the Attributes section, and enter additional

information in the user-defined and custom data fields that your library has set up. For more
information on user-defined and patron custom data fields, see the Polaris staff-client online Help.

A Profile

- Attributes
3 Afiributes
E4 Email 1D Mumber Privileges / Restrictions
# Address
. Phone/Fax . . X
Voter Registration Collection Use Only
A Nofificati
mcanons ::NCI'IE:- ﬂ
£ Preferences
Mot Currently In Use Parent/Guardian
@ Password
This field is required if the patron is a juven
[Eal Image

Parent/Guardian birth date

[ Restricted patron

License number

O Mew PCDF

4. Select Email in the navigation bar to go to the Email view, and enter the patron's email address and
alternate email address (if applicable).

A Profile
} Email
1 Aftributes
&3 Email Email Address Alt Email Address

# Address

. Phone/Fax

5. Select Address in the navigation bar to go to the Addresses section, and click the ADDRESS
button to add the patron’s address.

A Profile
Addresses
2 Attributes
£4 Email Address Check Date
© ADDRESS
# Address SM212016
. Phone/Fax
Term
& Noifications 1 [

8 Preferences
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The Address section expands.

Address Type City
Home ] COBLESKILL
Postal Code Jip+d: State
12043 MY
Street Address County
SCHOHARIE
Sireet Address Line 2 Country
usa ]
i DELETE

6. Enter the following information in the expanded Address section:

a. Select an address type in the Address Typebox.

b. Enter the postal code in the Postal Code box. The City, State, and County boxes are filled in
based on the postal code you entered. If these boxes are not automatically filled, you can type
the city, state, and county.

c. Type the patron’s street address in the Street Address and, if necessary, the Street Address
Line 2boxes.

d. Click/tap in the Address Check Date box, and select a date when the patron’s address
should be checked. Or, under Term select a number and select Years or Months. The
address check date changes when you select a term.

Address Check Date: T

09/08/2016 x I

sep [v] 2016 [v] ©

Su Mo Tu We Th Fr Sa

[

1 2 3
4 5 [ 7“ 910
n 11 12 13 14| 15| 16 17
| 18| 19 20 21| 22| 23| 24

| 25 26 27 28 29 30

7. Select Phone/Fax in the navigation bar and enter the patron's phone number(s) and fax number (if
applicable).

4. Profile Phone/Fax

L Aftributes

= Email Phone 1 Phone 2
35

# Address

L. Phone/Fax Phone 3 Fax

& Notifications

£ Preferences

8. Select Notification Settings to go to the Notification Settings section. 29



& Profile
£ Atkinaes Notification Settings
B4 Email Motices Address eReceipt Option
# Address (Mone) ] (None) ]
. Phone/Fax
A Notifications Hofification Opfion
8 Preferences Ermail Address 1‘ [ Additional TXT Motice
@ Password
&l Image Text Messaging Phone Wireless Carmier
(Mone) V] (Mone) V]

9. In the Notification Settings section, select from the following options:

a. Select the address type to which notices will be sent. The addresses must be entered in the
Addresses section to appear in this list. For example, if you specified a home address, it is
listed as Home.

b. Select the electronic receipt option in the eReceipt Option box.
c. Select the notification option to use in the Notification Option box.
d. If an additional text message notice will be sent to the patron, select the following options:

« Select the Additional TXT Notice box

» Select the phone (1, 2, or 3) to which text messages will be sent in the Text Messaging
Phone box.

« Select the wireless carrier in the Wireless Carrier box.

10. Select Preferences to go to the Preferences section.

A Profile
Preferences

1 Atfributes
B4 Email Exclude from Motices and Reminders Language
# Address English ]

N [ overdue ? &
. Phone/Fax

0 Hold [ Maintain Reading History

A notfications O Biling [J Do Mot Delete Record
4 Preferences O Aimost Overdue/futo-Renew [ E-mail Motices in Plain Text
@ Password U Patron Record Expiration O Exclude from Collection Agency
G image [ Inactive Patron

11. In the Preferences section, select the check boxes that indicate the patron's preferences:

a. Under Exclude from Notices and Reminders, select the notice and reminder types that the
patron does not want to receive.

b. If the patron speaks a language other than English, select it in the Language box.

c. Select the other applicable preference check boxes.

12. In the Password section, enter the patron’s password and re-enter it to confirm it in the Password
(Confirm) box.

If the passwords do not match, the Password (Confirm) box has a red border.
13. To save a patron’s picture in the record, go to the Patron Image section, and do the following steps:

Note:
To take a new patron photograph from a workstation, a webcam must be installed. If you are
30



running Leap on an iPad, you can use the iPad camera.

a. Select UPDATE IMAGE.
b. Click/tap SELECT IMAGE and select one of the following options:

« TAKE PHOTO - The camera opens. Take the patron’s photo and select
Use Photo to use the image as it was captured. You can select Retake to
take a new photograph.

« CHOOSE EXISTING- Browse and select the existing patron photo. On an
iPad, you can select the picture from the Camera Roll.

{ Photos  Camera Roll

A,

sl L

The picture is displayed in the Update Image view.

Update Image

c. Select SAVE to save the patron’s picture.

d. Select CLOSE to close the Update Image box and return to the patron’s record.

14. Select SAVE to save the new patron record.
If no similar patron records are found, the new patron record is saved.

If potential duplicate patron records are found in the database, a Record Not Saved dialog box
opens listing the potential duplicates.

Note:

You can update the photo by replacing it, or if you want to delete the photo, select it and
select DELETE.

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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You are here: Creating, Modifying, and Deleting Patron Records > Copy an Existing Patron Record

Copy an Existing Patron Record

You can copy a patron's registration information when registering a new patron who has similar

information, such as a family member.

To copy a patron's registration:

1. Open the patron record that you want to copy.
2. Click REGISTRATION to go to the Registration view.

3. Click COPY.

MS. LAURA IZQUIERDA ©

@ BLOCKS

&,Check OUt (0)  # Out (3) / Overdl

& Profile Profile

2+ Altributes.

= Email Barcode =

# Address |A12291954 X

. Phone/Fax Former Barcode

A Notifications A12291954B

ue (3) & Account ($107.94) @ Claims (1)

L REGISTRATION

/Lost(1) I Holds (4)

Registered At *

Community Library v

Patron Code *

Relired v

C REFRESH

/

COPY

More

GIRESULTS CLOSE

% Preferences DELETE

Last Name * Date of R

The patron record is copied and the Patron Registration page displays with the name Patron
Registration 1. Many field values are copied to the new patron record.

4. Enter the patron's name, barcode, and other information.

5. Click SAVE to save the new patron record.

Field values and settings copied to the new patron record.

Profile view

» Last name

» First name

» Middle name

« Title

o Suffix

» Registered Branch
» Patron Code

» Expiration Date

» Birth Date

» Gender
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Patron Registration 1
Profile
= Profile
& Attributes
= Emai Barcode * Registered At *
# Address Community Library ﬂ
& Phone/Fax Former Barcode Patron Code *
& Notifications Retired v
 Preferences
Last Name * Dale of Registration
& Password
1zquierda 3127/2015
(el Image
First Name * Expiration Date *
Laura 10/4/2018
Middle Name Birth Date
120111955
Title Suffix Statistical Class
(None) v Cobleskill-Town v
Gender *
O Male @ Female O NA

Attributes view

All field values are copied if defined: five user-defined fields (UDFs) and the patron custom data

fields (PCDFs) the library uses.

Attributes

ID Number

Voter Registration

Yes

Not Currently In Use

Parent/Guardian birth date

License number

122145454

Privileges / Restrictions

Library Use Only

(None)

Parent/Guardian

[ Restricted patron

[ New PCDF

Email view

« Email Address
o Alt Email Address

Email

Email Address

Alt Email Address

lizuierda@gmail.com

Addresses view

o All addresses
e Address Check Date
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Addresses

Address Type City
Home v SYRACUSE
Postal Code Zip+d: State
13210 NY
Street Address County
101 E. Main Street ONONDAGA
Street Address Line 2 Couniry
USA v
W DELETE
© ADDRESS
Address Check Date Term
8/28/2016 1 |v| Years  [v]
Phone/fax view
e« Phone 1,2,3
o Fax
Phone/Fax
Phone 1 Phone 2
315-512-5555
Phone 3 Fax

Notification Settings view

All field values and settings are copied.

Notification Settings

Notices Address

Home

Notification Option

TXT Messaging

Text Messaging Phone

Phone 1

eReceipt Option
v (None)

ﬂ [ Additional TXT Notice

Wireless Carrier

v Verizon

Preferences view

All field values and settings are copied.
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Preferences

Exclude from Notices and Reminders

[ overdue

O Hold

O Billing

[ Aimost OverduerAuto-Renew
[ Patron Record Expiration

[ inaciive Patron

Language

English

M maintain Reading History
O Do Not Delete Record
[ &-mail Notices in Plain Text

[ Exclude from Collection Agency

Polaris Version 5.6
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You are here: Creating, Modifying, and Deleting Patron Records > Delete a Patron Record
Delete a Patron Record

When a user attempts to delete a patron record in Leap, the same permissions and blocking conditions
are checked as with the Polaris ILS. For information about the blocking conditions that prevent deletion of
patron records, and the permissions required to delete patron records, see the Polaris ILS online Help.

To delete a patron record from Leap:

1. Open the patron record.
2. Choose DELETE.

A confirmation message appears.

Delete patron record

The patron record will be permanently deleted. Do you want to
continue?

3. Select CONTINUE to delete the patron record.

If there are any conditions that prevent the patron record from being deleted, a message (or
messages) is displayed.

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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You are here: Viewing and Modifying Patron Associations > Add a New Associated Patron
Add a New Associated Patron

To add a new associated patron to a patron’s record:
1. Open the patron record.
2. Select More | Associations.

The Associations view opens.

& Check Out (0) % Out (12)/ Overdue (12) b Account ($14.00) @ Claims (2) / Lost (0) I Holds (5) 4, Associations =

X New Association

[0 ! PATRON BARCODE PATRON NAME BRANCH NOTE BLOCK ME ALLOW ME
O 1004300052868 Elena C Acosta Amsterdam Free Library Yes

O 1001900123289 Genie R Ozolins Community Library Yes Yes

O 1001900162725 Brandon S Surento Community Library Yes

3. Click New Association.

The area below the button expands.

« FIND TOOL

Associated Patron(s) Note

[ Block me if these patron records are blocked CANCEL

I Allow me to pick up holds for these patrons.

[0 * PATRON BARCODE PATRON NAME BRANCH NOTE BLOCK ME ALLOW ME

O 1004300052868 Elena C Acosta Amsterdam Free Library Yes

4. Scan the patron’s barcode, or choose FIND TOOL to search for and choose the patron.
The patron’s barcode and name are displayed in the expanded area.

5. To add an optional note, type a note in the NOTE box.
6. If applicable, choose additional patrons to associate with the displayed patron record.

7. To block the patron if the associated patron is blocked, choose Block me if these patron records
are blocked.

8. To allow the patron to pick up held items for the new associated patron, choose Allow me to pick
up holds for these patrons.

9. Click ADD to add the associated patron(s).

The new associated patron or patrons appear in the associations list.
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You are here: Viewing and Modifying Patron Associations > Edit a Patron Association
Edit a Patron Association

To edit a patron association:

1. Open the patron record.
2. Select More | Associationsin the summary bar.

The Associations view is displayed.

r" SARAHR ACOSTA © 4 REGISTRATION C* REFRESH
P 1001900144202

COMMUNITY LIBRARY # BLOCKS O mnoTES
&:Check Out (0) @ Out (1) / Overdue (1) & Account (50.00) @ Claims (2)/Lost (0) ¥ Holds (2) 8 Associations ¥

X New Association Filter Associafions

(] PATRON BARCODE PATRON NAME BRANCH NOTE BLOCK ME ALLOW ME
1001800122877 Rebeksh E Fslotico Community Libear Yes

m} ty Libesry

[] 1004300052888 Elens C Acosta Amsterdam Fres Library Yes

[] 1001000123280 Gariie R Ozofins Community Library Yes Yes

[] 1001800182725 Brandon 5 Surento Community Libeary Yes

3. Select the check box next to the associated patron you want to modify, and choose EDIT.

r‘ SARAHR ACOSTA © 1 REGISTRATION CREFRESH
(M4 1001900144202

Y LIBRARY @ BLOCKS OinoTES
&, Check Out (0) W\ Out (1) / Overdue (1) b Account (§0.00) (D Claims (2)/ Lost (0) MW Holds (2) 18 Associations ~

X New Association & Edit i Delete @ Block 2, Disallow Fitter Associafions

[0 PATRON BARCODE PATRON NAME EBRANCH NOTE BLOCK ME ALLOW ME
[0 1001800122877 Rebeksh E Falotico Community Libeary Yes
1004300052262 Elena C Acosts Amsterdam Free Library Yes

The area below the button displays the settings for the associated patron.

fiDelete | @ Block & Aow Filler Associafions

Associated Patron Note

1004300052268 : Elena C Acosts

[ Block me if this patran record is biacked. m CANCEL

[ Allow me to pick up halds for these pstrons.

4. Select SAVE.

The patron association is modified.

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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You are here: Viewing and Modifying Patron Associations

Viewing and Modifying Patron Associations

You can create associations between two or more patron records so that when one record is open, all
associated patron records are conveniently accessible. For example, you might associate all members of
a family, so when checking out items to parents, you can quickly renew items or pay fines for their

children. Depending on your library's default settings in Polaris Administration, patrons may be blocked

when their associated patrons are blocked, and/or they may be allowed to check out items for their

associated patrons.

To find patron records that have associations, you can limit patron searches in the Find Tool using the

qualifier Has patron associations.

Find Tool - Patron

Patron »  Basic Search ¥ I me {Last, First Middle) ' Keyword (Al »
Fax )
Former barcode

Free text block

O Number

Language

Last activity date
Library-assignad block

License number W

Barcode I Has patron asseciations I ip | BirthD_..

To see the associated patrons, select More | Associations.

SARAHRACOSTA ©
4

@ BLOCKS [ noTES

& Check Out (0) BN Out (1) / Overdue (1) 5 Account (50.00) & Claims (2)/ Lost (0) ™ Holds (2)

« Find Tool

[0 earcope CALL NUMBER TITLE DUE DATE ACTION SHELF LOCATION

A REGISTRATION

(' REFRESH CLOSE

% Reading History
(@ Special Loar 3 Notices

L

W Messages
ASSIGNED BRANCH L]
o’ Blocks

=] Motes

If the patron has any associations, the Associations view displays a list. From this view, you can: add a

new associated patron; go to the associated patron's record; edit a patron association; or delete an

association.
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ré‘ SARAHR ACOSTA © 1 REGISTRATION C*REFRESH
[ 1001900144202
g f BLOCKS [ notES

& Check Out (0) W% Out (1)/ Overdue (1) B Account (50.00)  © Claims (2)/ Lost (0) ™ Holds (2) It Associations *

X New Associafion Fitter Associafions

[0 PATRON EARCODE PATRON NAME BRANCH NOTE BLOCK ME ALLOW ME

[0 1001800122877 Rebeksh E Falotico Cormmunity Library Yes

[ 1004300052888 Elena C Acosta Amsterdam Free Library Yes

[0 1001800123288 Genie R Ozolins Community Library as Wes

[0 1001800182725 Brandon 5 Surento Community Library Wes

When you select a patron in the list, the active buttons correspond to actions that are possible for the
selected patron. To select all the associated patrons, select the check box in the header line. The active
buttons correspond to actions that are possible for all the selected patrons.

£ New Associafion (# Edit if Delete o' Unblock 2 Disallow Filter Associations
[0 PATRON EARCODE PATRON NAME BRANCH NOTE BLOCK ME ALLOW ME
[] 1001800122377 Rebeksh E Fakotico Community Library Yes
[] 1004300052352 Elena C Acosta Amsterdam Fres Library Ves
E 1001800123289 Genie R Ozolins Commumity Library fes Wes

+ Add a New Associated Patron
o Edit a Patron Association
o Delete a Patron Association

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.

40


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Add_a_new_associated_pat.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Edit_an_existing_patron_.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Delete%20a%20patron%20association.htm

You are here: Viewing and Modifying Patron Associations > Delete a Patron Association
Delete a Patron Association

To edit a patron association:

1. Open the patron record.
2. Select More | Associationsin the summary bar.

The Associations view is displayed.
3. Select the check box next to the associated patron you want to delete and choose Delete.
A message box opens.

4. Select CONTINUE to delete the patron association. This does not delete the patron record, only the
association between the records.
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You are here: Patron Notes

Viewing and Modifying Patron Notes

The patron Notes view displays existing non blocking notes and blocking notes. You can add notes, edit
existing notes, and delete notes from this view. To see patron notes, select More | Notes. If the NOTES
button is yellow, the patron record contains notes. You can click on the information icon to see the note
creator and the date and time the note was added or updated.
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See also:

« Add a Patron Note
e Delete a Patron Note
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You are here: Viewing and Modifying Patron Notes > Add a Patron Note
Add a Patron Note

To add a patron note:
1. Open the patron record, Notes view.

2. Type notes in the NON BLOCKING NOTES or BLOCKING NOTES box.
3. Click UPDATE NOTES.

The notes are updated.
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You are here: Viewing and Modifying Patron Notes > Delete a Patron Note
Delete a Patron Note

To delete a patron note:
1. Open the patron record, Notes view.

2. Select the note you want to delete, and choose the delete button above the note.

NON Iili-:KIHGh-.‘:'ES@ BLOCEING NOTES &

The note no longer appears.

3. Select UPDATE NOTES to save your changes.
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You are here: Patron Blocks

Viewing and Modifying Patron Blocks

The BLOCKS icon is a red closed lock if the patron has blocks that prevent circulations or a green open
lock if the patron has no blocks. To see a patron's blocks, click the BLOCKS icon or select More | Blocks.
The blocks are listed with the block description and creation date.

To view more details about a library-assigned or free-text block, select the block in the list, and click
Properties.

HAROLD T SMYTHE ©
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The Block Properties window displays the user name of the staff member who created the block; the
date the block was created; the sign-in branch for the staff member who created the block; the
workstation where the block was created; and the staff member who modified the block and the date
modified (if the block was modified).

Block Properlies

CLOSE

See also:

o Add a Patron Block
e Delete a Patron Block
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You are here: Viewing and Modifying Patron Blocks > Add a Patron Block
Add a Patron Block

To add a patron block:
1. Open the patron record, Blocks view.
The list of blocks (if any) is displayed.
2. Click Add Block.

The area under the button expands.

Brary Assgned | Free Tex EANCEL

3. Add a library-assigned or free text block as follows:

» To add a library assigned block, choose Library Assigned and choose the block description
from the list box.

» To add a free text block, choose Free Text, and type the free text block in the box provided.
5. Click ADD.
The block is added to the list.

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.

46


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Patron_Blocks.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Patron_Blocks.htm

You are here: Viewing and Modifying Patron Blocks > Delete a Patron Block
Delete a Patron Block

You can delete patron blocks that are not system-generated, provided you have the appropriate
permissions. If you have permission to remove collection agency blocks, you can also delete these.

To delete a patron block:

1. Open the patron record.
2. Select BLOCKS.

The blocks list appears.
3. Select one or more blocks in the list, and choose the delete (trashcan) button.

The selected patron blocks are deleted.

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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You are here: Viewing and Modifying a Patron's Reading History
Viewing and Modifying a Patron's Reading History

You can view a patron's reading history if the library maintains reading histories for its patrons and the
Maintain Reading List option is selected in the patron's registration preferences.

To view a patron's reading history, open the patron's record and select More | Reading History.
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See also: Remove an Iltem from a Patron's Reading History
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You are here: Records and Record Sets Displayed in Leap Workforms > Item Record
ltem Record

If you have the required permissions set in Polaris Administration, you can search for, access, copy,
create, and modify item records in Leap.

The settings that apply to item records in the Polaris staff client (such as the loan period, item home
branch, and hold limited to) are also applied to item records displayed in Leap.

When you open an item record, it is displayed in the ltem Record workform.

Item Record 6 m AETIGNS- | LINKS- | CREFREs | meEsaTs PR
) a novel
14 5030 L
¥ (L il
Beult Fiction E i
| localion Hone Faeni Bam Brice $10.50
branch Commanity Libisry Sunigrest Branch Commanity Libesry reulaticn akatan In (| BHSAAE Todd:11 AM
£ et T i -
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FIND
lbsctinn Assigned Branc I ¥ L]
Shell Locaiion Frice
Meon_circulsi g

Teami posiary szt on Chiculation Suis

wt Displary in PAC

The ltem Record workform header displays the following information:

» The Information icon and Properties window - When you hover over the icon, the Properties window
displays the following information:
o Item Record ID
o Barcode
o Record Status
o Creator
o Creation Date
o Modifier
o Modification Date
o First Available Date

» The book jacket image (if one is associated with the item record)
« Title and author

» Barcode

» Call number

e Collection
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» Shelf location
» Owning branch

» ILL, eContent, Non-circulating, and Display in PAC check boxes - A check indicates the option is
active. For example, a check box in Display in PAC means the item appears in the Polaris
PowerPAC and Mobile PAC.

» Record status

» Bib control number - You can click the link to go to the bibliographic record.
« Parentitem

» Assigned branch

« Issue control number

» Price

» Circulation status

The ACTIONS menu includes the following options:

e Check In

» Place Hold

» Copy

» Delete

» Add to New Record Set

» Add to Existing Record Set

The LINKS menu provides links to:
» Holds Queue

The bottom part of the page changes depending on the selected view: Details, Circulation, Controls,
Blocks and Notes, History, Statistics, Record Set, Notices, or Source and Donor. If there are blocks or
notes associated with the item record, the Blocks and Notes icon appears in red.

Note:

If you use the Find Tool to access a record in Leap, a RESULTS button is displayed in the
record header. Select RESULTS to return to the Find Tool results. This button does not
display if you opened the record from a quick search or from a list view.

Item Record - Details View

If you have permission to modify item records, you can use the Details view to change the item record's
header information.
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Iltem Record - Circulation View

The Circulation view of the Item Record displays circulation information for the item.

Iltem Record - Controls View

The Controls view of the Item Record displays controls or settings for the item.
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ltem Record - Blocks and Notes View

The Blocks and Notes view displays blocks and notes associated with the item.
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Item Record - History View
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THE REGIONAL AUTOMATION CONSORTIUM

Notes Procedure

Please make sure when adding a note into an item record that the note is necessary and in the
appropriate spot. Below you will find a breakdown of the different note and block fields and what
information is appropriate for each.

(None)

Free Text Block

I
In

System Block

Public Note
Non-Public Note

Physical Condition

Public Notes

Only the owning library is permitted to enter comments in the public notes field and only if it
will be helpful to the general public as any information entered in this field will appear on
TRACpac for all patrons to see. No information that is already in the bibliographic record should
be added to this field. Only pertinent information to patrons regarding the owning library’s item
should be placed in the public notes field. If the information applies to all items associated to
the bib record it should not be entered in this field. Here are examples of suitable and
unsuitable notes for the public notes field:

Suitable Public Notes:
e Map is missing from this book
e Workbook can be found on shelves under 722.538

Unsuitable Public Notes:

e Newbery award winner (this information applies to all the items in the bib
record)

e Level 3 (this information would be better suited in the suffix field)

e Give to Bob for cleaning (this information can appear under free text or physical
condition)

e Coveris ripped (damaged notes belong in the free text block field)

e Softcover (this information is in the bib record)

e Please give to John Smith (no patron information should appear in this field)

e 8cds (this information can go in the free text block field)

This note field does not pop up in Polaris when the item is checked in or out.

Created September 2013
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Non-Public Notes

Only the owning library is permitted to enter comments in the non-public notes field. This note
does not show to patrons and will not pop up in Polaris when the item is checked in or out. This
field is suitable for comments internal to the owning library regarding their item.

Physical Condition Notes

Only the owning library is permitted to enter comments in the physical condition field. This
note will not show to patrons and will not pop up in Polaris when the item is checked in or out.
Damaged notes should only go in the free text block.

Free Text Blocks

All libraries may use this field for damage notes, reminder notes, contents notes, etc. that they
wish to alert the owning library or transacting library about. This note does not show to patrons
but does pop up in Polaris when the item is checked in or out. If a transacting library receives an
item that is damaged it is important to enter in a damaged note before checking the item out to
a patron or returning the item to the owning library. When entering a damage note in the free
text field please include your library’s national code and the date the note was entered. If you
are the transacting library do not delete notes that other libraries have placed. Only the owning
library may delete notes from the item record when necessary.

Created September 2013
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The History view displays the transaction history for the items. You can click the patron ID to go to the
patron record associated with the transaction.

[sATE ASSILNED BRARCH STATUS BCTHN CHCATHON ISERWHES

ltem Record - Statistics View

The Statistics view displays circulation and inventory statistics for the item.

Iltem Record - Record Sets View

The Record Sets view displays a table listing all the record sets to which the item record belongs. You can
click on a record set to open it in the Item Record Set workform. When you close the Item Record Set
workform, you are returned to this view. If you do not have the required permissions for the record set, an
error message appears.

HAM [FARLH TEHFT&L REC ORI CHEATMN DATE ROTLE

Iltem Record - Notices View

To view the notices associated with this item, select More | Notices. The Notices view displays the date
and time for the notices sent regarding this item.

Iltem Record - Source and Donor View
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To view source and donor information, including import information for eContent items, select More |
Source and Donor.
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You are here: Creating, Copying, and Modifying ltem Records > Modify an Item Record

Modify an ltem Record

If you have the required Polaris staff client permissions to edit item records, you can modify item records
in Leap.

You can edit the following fields on the Details view of the Iltem Record workform:

Note:
The following fields cannot be changed for electronic items: Non-circulating, Display in PAC,
Barcode, Bib Control Number. The Find Tool is also disabled so you cannot search for and
select a different bibliographic record.

« Barcode

« Collection

« Shelf Location

o Temporary Location

« Owning Branch

» Assigned Branch

» Price

« Circulation Status
Note:

If you change the item to an Unavailable status, and it is the last copy linked to that bib, you
can uncheck the Display in PAC box on the Bibliographic Record workform.

» Bib Control Number - Type a different bib control number or click FIND to search for and select a
different bibliographic records.

« Parent Item

» Display in PAC

You can edit the following fields on the Controls view of the Item Record workform:

» Material Type
» Loan Period

+ Renewal Limit
» Statistical Code
» Home Branch
» Do not float

« Call Number Scheme
» Cutter

* Volume

o Prefix

o Suffix

» Copy

» Classification
» Name of Piece

» Loanable outside system s
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» Do not mail to patron
« Holdable
« To indicate limits on the holds, use the check boxes under Hold Limited To:

o Pickup at this branch

o Patron from this library and branches
o Patrons from this branch only

o Preferred borrowers

You can edit the following fields on the Blocks and Notes view of the Item Record workform:

» Library Assigned Block

» Free Text Block

» Public Note

» Non-Public Note

» Physical Condition

» Special Item Check-In
You can edit the following fields on the Source and Donor view of the ltem Record workform if the item
record was not created from a purchase order:

» Funding source

» Donor First Name

« Middle

« Last Name

» Donor Organization

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.

60


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Item_Record.htm#leapstart_3788722609_1538685
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Item_Record.htm#Item4

You are here: Viewing Patron Notices and Associated ltems > View an Item's Notice History

View an Item’s Notification History

To view the notice history for a specific item in the patron's Notices list:

1. Open the patron’s record.
2. Select More | Notices to open the Notices view.

The Notices view is displayed.

3. Select a notice in the list to see the notification history. You can also select Item Record to view the

item's details.

Notification History

Title: Breath, eyes, memory [large print]
Material Type: Book
NOTICE METHOD DATE FROM  AMOUNT STATUS

Almest overdue/Auto-renew reminder Email 91672014 COB Email Completed

1st Overdue Email 91212014 COB Email Completed

ITEM RECORD CLOSE

Polaris Version 5.6
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You are here: Viewing, Renewing, and Modifying ltems Out to a Patron > View the ltem Record from the
Items Out List

View the Item Record from the Items Out List

To open the item record from the items out list:

1. Open the patron record.
2. Click the Out/Overdue tab.

The patron's items out list appears.
3. Select an item in the list.
The Item Record appears.

4. Click CLOSE to close the item record.

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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You are here: Checking In ltems and Managing Fines > Change Item Information or Barcode During
Check-In

Change ltem Information or Barcode During Check-In

When checking in items in Leap, staff members who have the appropriate Manage item dialogs
Circulation permissions can edit specific fields for a single or multiple items, or replace the item barcode
for a single item. These Circulation permissions allow staff members to modify certain fields at check in
even if they do not have the Cataloging permissions necessary to modify all fields in item records.

If you have the required permissions, you can select one or multiple items and use the Manage Item
Record option to change the collection, shelf location, material type, circulation status, non-public note,
library assigned block, or free text block. The Replace Barcode option is available only when a single
item is selected. For more information on these Circulation permissions, see Polaris staff client Help.

To modify items at check-in:

1. Select CHECK IN.
2. Select the check boxes next to the items you want to modify.
3. Select ACTIONS and choose Manage Item Record in the drop-down list box.

Check In
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The Manage ltem Record dialog box opens.
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4. Select the check box for the item record field to modify.

5. Select the new value in the drop-down list box.

6. Select OK.
The message Item record(s) updated successfully appears if all the changes can be made to all
the selected records. A transaction is added to the database for each changed item. In addition, the

Iltem Record workform, History view displays a row for each change that was made to the item
record, for example: Assigned collection modified via Manage Item dialog from Check In.

If one or more of the selected records cannot be changed, the following types of messages appear:

» Locked item [barcode] cannot be modified from check-in. This message appears if
the item record is locked (open) in either the Polaris staff client or Leap.

« Item [barcode] must be in and from this branch. This message appears if the item
status has been updated to a status of other than In but the Check In workform displays
an In status, or the item's assigned branch has been changed but it still displays as the
logged-on branch in the Check In workform.

« Quick-circ item [barcode] cannot be modified from check-in. This message
appears if the item is a Quick-circ item.

« ILL item [barcode] cannot be modified from check-in. This mes-sage appears if the
item was created via Polaris ILL.

To replace the item barcode for a single item:

Note:
The Replace Barcode option appears only when a single item is selected.

1. Check In an item.
2. Select the checked-in item in the list.
3. Select ACTIONS and choose Replace Barcode in the drop-down list box.
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The Replace barcode dialog box opens.

Replace barcode

Enter a new barcode for this item:
Mystery of the flying express

o I

4. Type the new barcode in the box, and choose OK.

The item's barcode is changed.
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N
NG




68



You are here: Records and Record Sets Displayed in Leap Workforms > Bibliographic Record
Bibliographic Record

If you have the required permissions in Polaris Administration, you can search for and access
bibliographic records in Leap. When you open a bibliographic record, it is displayed in the Bibliographic
Record workform.

Eibliugraphic Record @ ACTIONS = LIMKE ~ {* REFRESH ! RESALTS
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Bibliographic Record Workform - Header

The top part of the Bibliographic Record workform displays the header information that identifies the
bibliographic record.
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You can hover the cursor over the information icon to open the Properties window and see information
about the record. If you have the required permissions, you can edit the following elements in the header:
Owner, Display in PAC, and Do not overlay. Then click SAVE to save your changes.

The ACTIONS menu includes the following options:

« Place Hold
e Create Item

¢ Delete 69
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« Add to New Record Set
» Add to Existing Record Set

The LINKS menu provides links to:

e Holds Queue

« PAC - The title is displayed in the Polaris PowerPAC. You can close the browser window to return to
the Bibliographic Record workform.

The bottom of the page changes depending on the view selected. When the Bibliographic Record
workform opens, Preview is selected.

Note:

If you use the Find Tool to access a record in Leap, a RESULTS button is displayed in the
record header. Select RESULTS to return to the Find Tool results. This button does not
display if you opened the record from a quick search or from a list view.

Bibliographic Record - Preview

This is a preview of the Brief display in the PAC. You can choose Full or Availability to change the PAC
view.

Hal of 3 yeloaw sum - 3 noved I | I

Niw Yiork | Aitred A,

Bibliographic Record - Items View

The items view displays information about the item records linked to the bibliographic record, including the
due date (and time for hourly loan) in the Status column for items with a status of Out or Out-ILL. Select
an item in the list to go to the item record. If you have the appropriate permissions, you can click NEW
ITEM to add a new item linked to this bib.

W T M AR iy Haar ™ 1 e -

MATERIAL SHELF CALL LAST RECORD CONTROL
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Bibliographic Record - MARC view
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The MARC view displays the MARC tags and fields. The MARC view cannot be modified in Leap.

Bibliographic Record - Headings View

The Headings view displays the headings linked to the bibliographic record. If there are no headings
linked to the bibliographic record, the following message appears: No authority headings exist for this
record. You can click a heading to go to the authority record. When you close the authority record, you
are returned to this view.

CNTRDI SEE AL SO
HEADIMG HLMEE R RECORD STATUS  BIB COUMT COUNT HENE SLE. T SERES

Bibliographic Record - Statistics View

The Statistics view displays circulation information about the hold requests and items linked to the
bibliographic record:

Bibliographic Record - Record Sets View

The Record Sets view displays a table view of the bibliographic record sets to which the bibliographic
record belongs. All record sets that contain this record are displayed in this view regardless of record set
ownership. You can click a record set to open it in the Bibliographic Record Set workform. However, if you
do not have permission to access the record set, the following message appears: You do not have
ownership rights to open this record set.
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Bibliographic Record - Resources View

The Resources view displays resource entity information only if the bibliographic record is for integrated
eContent.

CrearDinve - Clark County
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You are here: Using the Leap Find Tool
Using the Find Tool

The Leap Find Tool features and functions are similar to those available in the Polaris staff client Find Tool.
However, you cannot search for all record types, search external Z39.50 targets, or perform certain functions
from the Find Tool results list in Leap.

With the Leap Find Tool, you can do the following:

« Search for authority, bibliographic, hold request, ILL request, item, and patron records.
« Search for item, bibliographic, authority, or patron record sets.

» Do a basic search, a power search, or an SQL search.

« Specify the columns in the Find Tool results list and the order in which they appear.

« Add filters to narrow your search.

« Save search and column settings as your user default when searching for records.

« Get a quick count of the records that meet your search criteria without returning the results list.
« Send all Find Tool results to a new record set.
« Select records in the Find Tool results list and put them in a new or existing record set.

Find Tool System Administration Settings Applied to Leap

Polaris Find Tool permissions, such as those for setting up and saving SQL searches, are checked in the Leap
application. In addition, if your library has set the Find Tool: Filter search results by permission Staff Client
profile to Yes in Polaris Administration, Find Tool results are filtered by the user's permissions.

When you create a record set in Leap from all Find Tool results or from another record set, a warning message
may appear depending on the number of records being added to the record set and the setting in the Polaris
Administration Staff Client profile Find Tool/record-set-to-record-set creation: Record set size warning.

The following Polaris Administration Staff Client profile settings do not apply to the Leap Find Tool:

« Find Tool: Default number of records to return in a result set
« Find Tool: Use initial article table
« Find Tool: Use language scoping display
The Polaris ILS performance issues that may be encountered with large search results sets do not apply to

Leap. In Leap, the results are returned in a virtual result set with 10,000 as the set maximum. The results are
filtered by permission by default without regarding the Administration setting.

Initial articles are not stripped out when exact match searches are done, and Leap does not use the initial article
table. In addition, Leap has its own automatic suggestions and does not use the Cataloging parameter Auto-
suggest feature enabled.

See also:

« Do a Basic Search for Records or Record Sets
« Search for Records and Get a Count
* Do a Power Search
» Save a Power Search
» Browse Search for Bibliographic Records
« Set Up and Save an SQL Search
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+ Rename a Saved Search

e Delete a Saved Search

« Apply a Filter to a Find Tool Search

» Specify Columns for Search Results

» Save a Set of Find Tool Search Options as Your User Default
« Sort Find Tool Search Results List
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You are here: Creating, Modifying, and Deleting Patron Records > Use the Find Tool to Search for a
Patron

Use the Find Tool to Search for a Patron

To search for a patron using the Find Tool:
1. Sign in to Polaris Leap.
The Circulation page opens.
2. Click FIND.
The Find Tool opens with Bibliographic Record selected as the search database.
3. Select Patron to change the search database.
4. Enter the search criteria.

As you type, automatic suggestions appear.

Find Tool - Patron ]

5. Open the patron record:

« If the patron is listed in the automatic suggestions list, select the patron, and click OPEN.
« If the patron is not listed in the automatic suggestions, click E] to search, then select the

patron in the search results and click OPEN.

The patron's record opens.

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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You are here: Using the Find Tool > Do a Basic Search for Records or Record sets

Do a Basic Search for Records or Record Sets

Note:
You can set and save your own user defaults for the Find Tool.

To search for a patron, item, bibliographic, authority, hold request record or ILL request record, or a record set:

1. Open the Find Tool.
2. Select the record type or record set if it is not already selected.

Find Tool - Bibliographic Record

Biblicgraphic Fecond E

D TO RECORD SET = CAMNCEL
3. Select Basic Search.
4. Select the search by access point or qualifier.
Find Toal - Bibhographic Record
b
A =

Count Ol ABD To RECORD SET = EANEEL
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5. Select the relation option. The options depend on the selected search by access point or qualifier.

For example, if All keyword fieldsis selected as the access point, the selections areKeyword (All),
Keyword (Any), and Phrase.

Find Tool - Bibliographic Record

CANCEL

If the search type supports implicit truncation, Exact (*) is selected by default.

Find Tool - Bibliographic Record

@D

6. Enter the search term or choose the search option (qualifier):

« [f the search access point does not have an associated list, type the search term. For
example, if you search for a bibliographic record by Author, type the author’s name.

« If alistis displayed, click the appropriate check boxes. For example, if you are searching for
record sets and select Type, you can select the record set type.

Note:
When multiple check boxes are selected, an OR is implied between the selections.

o
0
I

7. (Optional) Apply additional filters.
8. Click m to start the search.

The search results list is displayed.

9. Select the record in the list, and click OPEN.
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The record or record set workform opens.
10. To return to the Find Tool results list, click ™=+

Note:
Only the icon appears on this button when displayed on a narrower screen or window.
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Open topic with navigation

You are here: Using the Find Tool > Specify Columns for Search Results
Specify Columns for Search Results

To specify the columns to display in search results:

1. Open the Find Tool.
2. Go to the options menu.
3. Select Column Settings.

4. The Column Settings dialog box opens.

E Column Sactings
Fi : : Display Pesstion
B Bt Fodtied
i Fo Hama
i Link Fianad Fakes
bl ok Vhibie Tows:
) Ol Vi a5
b Cal
W Con

Diinjlay Pesition

The crder of T colsmn in e deplay

MOVE DOWR

CANCEL

When you select a column heading, you can view the column settings: Display Position, Folded, Name,
Pinned, Visible, and Width. Column settings that display in black type can be modified; those that display
in gray type cannot be modified.

Note:
When you select a column setting, the definition is displayed in the shaded box.

The column settings are as follows:

« Display Position: The order in which the columns display from left to right, with 1 being the
first column on the left. To change the display position, select the MOVE UP or MOVE DOWN
button.

» Folded: Indicates whether a column will be “folded” to a secondary line. When set to True,
the column is folded; False is not folded.

» Pinned: Indicates whether a column will move when scrolling the results list horizontally.
When set to True, the column is pinned; False is not pinned.

« Visible: Indicates whether a column will be visible. When set to True, the column is visible;
False is not visible.

« Width: The width of the column in characters. The minimum setting is 2, and the maximum
setting is 255.
5. Select the check boxes for the columns to display in the Find Tool search results.
6. Select the MOVE UP or MOVE DOWN button to change the position of the column from left to right.
7. Select OPEN when you have finished defining the columns for search results.
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You are here: Using the Find Tool > Apply a Filter to a Search
Apply a Filter to a Find Tool Search

To apply a filter to limit search results:

Note:
You can apply filters and save them in your user defaults.

1. Select FIND in the Leap header, or select the FIND TOOL button to open the Find Tool.
2. Set up the search criteria.
3. To open the Search Filter view:

« Select the filter icon.

Find Toal - tem Record

T =

e Or, choose the slide-out button and choose Search Filter.

>

Ll Setlings
Search Fille »

4. On the Search Filter view, select ADD CONDITION.

Fird Tool - em Recosd

Bearch Fitler

4 D CONHTION

The search filter options appear.

5. Select the access point. For example, Circulation status.
6. Select the qualifier. For example, =.
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Note:

To see the Contextual Query Language (CQL) that composes the query, select the Preview

@®

Query button

8. When you have added all the filters for the search, select APPLY.

The Search Filter view closes.

9. Select the search button [El

The search is initiated with the filter applied.
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Open topic with navigation

You are here: Using the Find Tool > Save a Set of Find Tool Search Options as Your User Default
Save a Set of Find Tool Search Options as Your User Default

You set up a search and save it so that these Find Tool search options are selected when you open the Find
Tool in Leap.

You can save the following search options as a user default.

« Database (record type) - Patron, Item, Bibliographic
« Mode - Basic, Power, SQL

» Qualifier - Name, Title, Author etc.

« Columns in search results display

Order of the columns in search results display
To save a set of search criteria and search results columns:

. Open the Find Tool.
. Select the record type or record set.

. Select the search mode.
. Select the search qualifier (access point or search by) option.

. Select the search relation.

oo O B~ W N -

. To include specific columns for search results in your user default, set up the columns. See Specify
Columns for Search Results.

7. Select the star icon.
A dialog box opens.
8. Select Save the current search and column settings as the user's default.

Note:
To see the changes that will be made when you save the current search and column settings, select
Show pending changes.

9. Select SAVE.
The dialog box closes and the star icon is displayed in yellow, indicating your user defaults are saved.

Note:
To return to the system defaults, select the star icon again and select Revert to system default
search and column settings.
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You are here: Records and Record Sets Displayed in Leap Workforms > Hold Request
Hold Request

To access a Hold Request record, you can search for the hold request using the Find Tool, or you can link
to a hold request from the Holds Queue, the Patron Record workform, or the Item Record workform. The
Hold Request workform includes a header and the following views: Details, Notes, Satisfied By, History
and All Hold Requests.

Hold Request Workform - Header

The Hold Request workform header includes general information about the hold request, including a Bib
control number link to the bibliographic record and a Patron barcode link to the patron record. The
header information does not change when you select another workform view.

To perform an action on the hold request, select ACTIONS and choose an action from the list:

Note:
The list of available actions depends on the status of the hold request.
« Cancel - Cancel the hold request
» Reactivate - Reactivate the hold request
» Delete - Delete the hold request
« Fill Now - Scan an item barcode to fill the hold request.

To go to the Holds Queue, select Links | Holds Queue

Heold REQUESt 1] ACTIONS = LINKS - (= REFRESH I RESULTS
SWING TIME
SMITH Statuns. Actvs BAINTT This iem arly Palron nasss: Nasir iz
SWING
TIME |

When you open a hold request that another staff member has open in either Leap or the Polaris staff
client, the following message appears: The record is being modified by [username]. In addition, a red key
icon indicates the record is locked. You cannot make any modifications to a locked hold request, but you
can still click a link to go to another record. Click the key icon to see information regarding the object lock.

Hold Request Workform - Details View

The Details view of the Hold Request workform appears when you first open the workform. It includes the
pickup branch, the activation date, expiration date, bibliographic information, item information (if the hold is
item-specific), and constituent/title information if the hold request is placed on a Bound-With title.
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Hold Request Workform - Notes View

The Notes view displays any notes that may have been entered for a hold request. You can enter notes in
the Staff Display Notes, Non-public Notes, and PAC Display Notes fields.

& Diet - ed By 8 Hl -

Staft Dispday Mot

Mo grublic Hotss

PAC Display Kodes

Patron Kotes

Hold Request Workform - Satisfied By View

The Satisfied By view lists all the items that can fill the hold request. You can select an item in the list to
open the ltem Record workform.
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Hold Request Workform - History View

The History view displays the history for this hold request.
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Hold Request Workform - All Hold Requests View

The All Hold Requests view displays all hold requests for the bibliographic record, including requests

with an Inactive, Cancelled, Expired, Unclaimed, or Out to Patron status.

Note:

The default sort order for this view is by patron, but you can click any column header to

change the sort.

-
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You are here: Viewing and Managing a Patron's Hold Requests > View a Hold’s Details and History
View a Hold Request’s Details and History

To view a hold request’s details and history:

1. Go to the Patron record | Holds view.
2. Select a hold in the list to open it.

The held title’s details are displayed.

3. To view notes, go to the bottom of the hold details view, and select the arrow next to Notes to
expand the area.

4. To go to the Hold Request workform, click the Request ID link.

Bib controd number Activation
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Ko, Lisa, auwthor STB1E1606S8

5. To view the request history, select the arrow next to Request History to expand the area.

Below the notes is the Request Satisfied By list of items that can fulfill the hold request.
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You are here: Records and Record Sets Displayed in Leap Workforms > Holds Queue
Holds Queue

From the Holds Queue, you can view hold requests for a specific title or item; change the order in which
requests are filled; and place new hold requests.

To go to the Holds Queue workform, select Utilities | Holds Queue. Then search for the title
(bibliographic record) for which you want to see the hold requests.

Holds Queue I PLACE HOLD (" REFRESH ¥ RESULTS

Lincoln in the bardo : a novel

POSITION FATRON HAME PATRON BRARCH STATUS FICKEUP BRANCH WOLLIME 155U REQUEST DATE EXFIRATION DATE
Landa, Addania Fosa Commsnily Libiasy At Cossimanily Lisrary BAGUNT anaar
Anderson, Gearge P Commenity Library ATt Commenity Library BB F AnacgF

Kamal, Anar Community Library At Community Library BAIINT FAE i

The Holds Queue has two views: the Holds Queue view, which displays the Active holds associated with
this bibliographic record, and the All Holds Requests view, which displays all linked hold requests,
including those with a status of Inactive, Cancelled, Expired, Held, Unclaimed, or Out to Patron.

On either view, you can filter the list by typing in the Filter Holds box. The list immediately responds
displaying the rows that have text matching the characters entered.

Example:
If you type Ship in the Filter holds box, the list displays the rows with a Shipped status.

You can click on a row in either view to open the Hold Request workform.
See also:

» View and Reorder Hold Requests in the Holds Queue
» Place a Hold Request from the Holds Queue
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You are here: Placing and Managing Hold Requests > Place a Hold Request from the Bibliographic
Record

Place a Hold Request from the Bibliographic Record

To place a hold request on a single title from the bibliographic record:
1. Open the bibliographic record.
2. Select PLACE HOLD.

The swan gondola
"M Wy scharert, Timothy:

BibliOgraphic Record I PAC C REFRESH FIRESULTS ﬁ

Control number: 990175
Owner: QA-Quantum 5.0 (sys)

Record status: Final

If patron records are open, the Select a patron box opens, and you can select the patron if he or
she is placing the hold.

Select a patron

FPATRON
O Aner Kamat

) Ms. Lawra Izquierda

“ FIND TOOL ... CAMCEL

If the patron record is not open, select FIND TOOL... and search for the patron.

When you select the patron, the patron’s record opens to the Holds view with the title selected.
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ANAR KAMAT ©

1001900146413

A REGISTRATION

C REFRESH CLOSE

COMMUNITY LIBRARY & BLOCKS [inoTES
& Check Out (0) @\ Out (2) / Overdue (0) &3 Account (30.00) ) Claims (0) /Lost (0) ™ Holds (4) More *
More - Filter Holds
Activation Expiration Pickup
061372015 6282015 Community Library PLACE HOLD CANCEL
Title
The swan gondola « FIND TOOL
Author Edition Pages
Schaffert, Timothy.
Series. Call NO Issue
Publisher LCCN Serial Copy
2013030317
ISBNASSN Format Tracking Number
9751594436093 (hbk.) - Book
Barcode Date
Scan a barcode 2014

3. Review the information and select PLACE HOLD. For more details, see Place a Single Title-Level
or Item-Level Hold Request for a Patron

Polaris Version 5.6
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You are here: Placing and Managing Hold Requests > Place Multiple Holds for the Same Patron
Place Multiple Hold Requests for the Same Patron

To place multiple holds at once for the same patron:
1. Go to the Patron record | Holds view.
The patron’s holds list is displayed.
2. Select More | Multiple Holds.

The area below the button bar expands.

Activation Expiration Pickup
12/21/2015 1/5/2016 Community Library ﬂ CANCEL
CALL
[0 auTHOR TITLE FORMAT ASSIGNED BRANCH NUMBER ITEM BARCODE

ADD TITLES jmf

3. Select ADD TITLES to open the Find Tool.
4. Search for the titles that the patron wants to request.
The search results are displayed.
5. Select one or more check boxes next to the titles on which the patron wants to place a hold.

Note:

You may be able to search for and select multiple titles at once and select them in the Find
Tool results. For example, if the patron wants to place holds on multiple titles with the same
author, you can search by author and select the titles in the Find Tool results list.

Find Tool - Bibliographic Record

Bibliographic Record »  Basic Search »  Author »  Keyword (All) »

thomas mann E

Title Author Format Li.. H.. Pub..  Call Number | Contr...
Joseph and his brothers Mann, Thomas... Book 4 0 1948  Fict 63279
Joseph in Egypt Mann, Thomas... Book 12 0 1938  FictMan 63330 "
The Holy Sinner Mann, Thomas... Book 2 0 1951  FictMan 63333

Joseph and his brothers Mann, Thomas... Book 1 1] 1934  Fict 63335

The transposed heads : a legend of India Mann, Thomas... Book 1 0 1941 Fict Man 63656

Young Joseph Mann, Thomas... Book 1 0 1935  Fict Man 63657
Confessions of Felix Krull, confidence man :...  Mann, Thomas... Book 6 0 1955  Fict Man 69087
Death in Venice. Mann, Thomas... Book 2 0 1965  Fict 690383

The magic mountain <Der zauberberg> Mann, Thomas... Book 3 0 1927  Fict 69089 R4

Ready 106 result(s)
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6. Select OPEN.
The titles are displayed in a list, but the holds are not placed until you select PLACE HOLD.

Activation Expiration Pickup
12/21/2015 1/5/2016 Community Library ﬂ S CANCEL
CALL
¥ AUTHOR TITLE FORMAT ASSIGNED BRANCH NUMBER ITEM BARCODE
& Mann, The Holy Sinner Book
Thomas,
1875-1955.
[ Mann, Death in Venice. Book
Thomas,
1875-1955
& Mann, Confessions of Felix Krull, confidence man Book
Thomas, the early years.
1875-1955.
v Hesse, The Hesse-Mann letters : the Book
Hermann correspondence of Hermann Hesse and
1877-1962. Thomas Mann, 1910-1955
& Mann, Joseph and his brothers Book
Thomas,
1875-1955.
) Mann, Joseph in Egypt Book
Thomas,
1875-1955.
ADD TITLES jmj
* Notes

7. To add more titles, select ADD TITLES, and search for and select the additional titles.

8. When all requested titles are displayed in the list, select the check boxes next to the titles, or select
the check box in the column header to select all titles.

9. If you want to enter notes regarding this hold request, select Notes to expand the area and type the
notes.

10. Select PLACE HOLD.

The hold requests are placed on all the selected titles.
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You are here: Viewing and Managing a Patron's Hold Requests > Group Multiple Holds
Group Multiple Holds

You can group several titles if any one of the titles will satisfy a hold request. When one of grouped
requests is filled, the other requests in the group are deleted. The group is counted as a single request
against the patron’s total request limit.

To group multiple holds:

1. Open the patron’s record.
2. Select Holds.

The patron’s hold list is displayed.

3. Select the holds to group.
4. Select More | Add to Group.

@ MR. GEORGE P ANDERSON o L REGISTRATION C'REFRESH CLOSE
i BLOCKS ) NOTES
& Check Out(0) i Out (6)/ Overdue (6) B9 Account ($38.55) (@ Claims (0)/Lost (0) M Holds (3) More =
) New Hold
CALL ACTIV] HOLD
M aAuTHORY  TITLE FORMAT NUMBER bEys ¥ Add To Group QUEUE UNTIL GROUP
[ Herbert, Don.  Mr. Wizard's supermsrket science Book J507.2H G152 1
[ Multiple Holds
& Renner AlG. | Experimentsl fun with the yo-yo and other science Book G18/2015 Active  Community 1
projects Litrary
& Shalt, Science magic fricks Book J783.8 Sha B15/2015 Pending = Community 1
Nathan. Library

The holds are grouped, and the letter A displays in the Group column.

) New Hold More
CALL ACTIVATION PICKUP HOLD
O AuTHOR v TITLE FORMAT NUMBER DATE STATUS BRANCH QUEUE UNTIL
O Herbert, Don. Mr. Wizard's supermarket science Book JB0T2ZH BM52015 Pending Community 1
Library
O Renner, AIG. Experimental fun with the yo-yo and other science Book B152015 Active Community 1
projects Library
[0 Shalit, Science magic tricks. Book J793.8 Sha B/18/2015 Pending Community 1
Mathan. Library
Note:

To remove titles from the grouped holds, choose the check box next to the title and choose
arrow button.

When you scan the item that fills the hold request for any of the titles in the group, the hold is placed
on the selected title, and the other titles in the group are no longer listed.
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You are here: Viewing and Managing a Patron's Hold Requests
Viewing and Managing a Patron's Hold Requests

The patron’s holds list is displayed when you select the Holds tab on the Patron workform. The tab
indicates the total number of holds and the number of held items.

When you select an item in the list, you can perform the following actions if the button or option is
available: Cancel, Reactivate, Delete, Fill Now, Deny, or Ask Me Later. You can also select the
following options (if available for the selected hold requests) from the More menu: Return, Addto Group,
Remove from Group, and Multiple Holds.

Note:
Depending on the width of the application view, some action buttons may appear under the
More menu instead of in the button bar.

When you access a locked hold request, a message indicates the record is being modified by another
user. You can click the LOCKED indicator to display the locked information.

You can place a single or multiple hold requests from this view by clicking New Hold.

A ALEXANDRIA LEE REMEY © 4 REGIETRATION  REFRESH CLOSE
# BLOCKS
& Check Out W Cut (1 verduz (1) K A 5 - " L - H 1 (2 M
CALL ACTIVATION PRCRUPE HOLD
AUTHOR v TITLE FORMAT MNUMBER DATE STATUS BHANCH QUEUE  LNTIL EROUP
AkhGorikiya Yaeta Pafic in @ seilcaia @ @ i Baok F EM472014 Unec laisia Capirmiusit BI04
Libwary
[cF w in ha timsa of chokera Book Fict Gar L9A1E Shipred Eashan Librarn
152
Gl 1 oim. 1 Taa fipping | hiow ke thin I 6301 1 B 14

B Jackson Fichard L, 153 Black writers and the Fis panic canon Baook B 9 U 11/ 1072018 3 il pmaect Cambridge
Public Libeary

Library

WVindimispvich, 1680-1977 ey mibad Mabok o Libwary

Rusdo, Richand, 1545 auhi Every bady's s Baok ESANT Aitive Cammiusity

See also:

+ Modify a Hold

» Fill a Hold Now

e Group Multiple Holds

» Cancel a Hold

» Deny a Hold

» Reactivate a Hold

» Change the Pickup Branch for a Held or Shipped Hold Request
» Set a Hold Request to Ask me later
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» View a Hold Request’s Details and History
» Delete a Hold
» Rerouting and Transfer Messages for Held Items with Changed Pickup Branch
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You are here: Viewing and Managing a Patron's Hold Requests > Modify a Hold

Modify a Hold

To modify a patron’s hold request:

1. Go to the Patron record | Holds view.

The patron’s holds list is displayed.

2. Select a hold in the list to open it.

The hold details are displayed.

Note:
To go to the Hold Request workform, click the Request ID link.

o Check Out (0) % Out (2)/ Overdue (2) & Account ($47.50) (@ Claims (0) / Lost (0) M Holds (5)/ Held (1)  B§ILL (1)/ Held (0) More =
© Cancel & Fill Now | % Convert To ILL More ~

Request ID Bib control number Activation P —

853119 1395762 9812017 ‘ ‘ CLOSE
Pickup Expiration

Community Library v 92372017
Status Request date Origin

Active 9/8/2017 9/812017 Library

This item only Borrow by mail Tracking number

Title Barcode Format

The leavers : a novel Book
Author ISBN/ISSN Pages

Ko, Lisa, author. 9781616206888 -
Series Edition Issue

First edit

Publisher Call NO Serial Copy
Date LCCN Volume

2017 2016043934

3. Modify the hold as follows:

To change the date range for which the hold is active, click/tap inside the Activation
box and choose the beginning date from the calendar. Then click/tap inside the
Expiration box and choose the ending date from the calendar.

To change the branch where the patron will pick up the item, choose a branch in the
Pickupdrop-down list box.

To change the notes that display with the hold request, choose the arrow next to Notes
to expand the Notes area, and enter or edit the notes.

To change the date range for which the hold is active, click/tap inside the Activation
box and choose the beginning date from the calendar. Then click/tap inside the
Expiration box and choose the ending date from the calendar.

To change the branch where the patron will pick up the item, choose a branch in the
Pickupdrop-down list box.
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» To change the notes that display with the hold request, choose the arrow next to Notes
to expand the Notes area, and enter or edit the notes.

~ Notes

Staff Display Notes

Non-public Notes

PAC Display Notes

4. When you are finished editing the hold request, choose SAVE.

The hold request is modified.
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You are here: Viewing and Managing a Patron's Hold Requests > Cancel a Hold
Cancel a Hold

To cancel a hold:
1. Go to the Patron record | Holds view.
The patron’s hold list is displayed.
2. Select the check box next to the hold you want to cancel, and choose Cancel.

The hold is canceled, and the status is updated in the holds list.
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You are here: Viewing and Managing a Patron's Hold Requests > Reactivate a Hold
Reactivate a Hold

You can reactivate Canceled, Expired, and Not-supplied hold requests to permit items to fill them. When
you reactivate a hold request, the request becomes active with a new expiration date.

To reactivate a hold:
1. Go to the Patron record | Holds view.
The patron’s holds list is displayed.
2. Select the check box next to the canceled, expired, or not-supplied hold request to be reactivated.
3. Select Reactivate to reactivate the hold.

The hold request is reactivated.
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You are here: Viewing and Managing a Patron's Hold Requests > Delete a Hold

Delete a Hold

To delete a hold:
1. Go to the Patron record | Holds view.
The patron’s hold list is displayed.
2. Select the check box next to the hold you want to delete, and choose Delete.

Note:
The Delete button is active only when the hold can be deleted.

The hold is deleted and removed from the patron’s holds list.
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You are here: Viewing and Managing a Patron's Hold Requests > Change the Pickup branch for a Held or
Shipped hold request

Change the Pickup Branch for a Held or Shipped Hold Request

To change the pickup branch for a hold request with a status of Held or Shipped:

Note:
The pickup branch list in Leap excludes branches (if any) selected in the Request parameter:
Hold options | Pickup | Exclude selected branches in staff client.

1. Go to the Patron record | Holds view.
2. Select a hold with a status of Held or Shipped.

The Hold Request page opens.
3. Select a different pickup branch in the Pickup drop-down list box.
4. Select SAVE.

A message informs you that the hold was modified, and the pickup branch is changed in the holds
list.

Note:

When a hold request pickup branch is changed for an item held at another branch, a message
alerts staff members at the other branch that the pickup branch was changed so that they can
ship the item to the new pickup location. Leap also indicates if the pickup branch for a held or
shipped item was changed in PowerPAC, Mobile PAC, Leap, or the Polaris staff client. See
Rerouting and Transfer Messages for Held Items with Changed Pickup Branch.
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You are here: Viewing and Managing a Patron's Hold Requests > Rerouting and Transfer Messages for
Held Hold Requests with Changed Pickup Branch

Rerouting and Transfer Messages for Held Items with Changed
Pickup Branch

If the pickup branch is changed (from PowerPAC, Mobile PAC, the Polaris staff client, or Leap) for a hold
request with a status of Held, and that item is being held at a branch other than your logged-in branch, the
following message displays in the PICKUP BRANCH column of the Holds view: Rerouting from: original
pickup branch to: new pickup branch.

SARAHR ACOSTA © 2 REGISTRATION C REFRESH

# BLOCKS CINOTES

& Check Qut (0) v Out (14)/ Overdue (1)  Sp Account ($17.50) @ Claims (2)/Lost (0) ™ Holds (6) More ¥
] New Hold More ~
CALL ACTIVATION HOLD
1 AUTHOR TITLE FORMAT NUMBER DATE STATUS PICKUP BRANCH & QUEUE UNTIL GROUP
EE Heyer, Georgette, The nonesuch Book Fict 8/26/2015 Held Rerouting from: Hudson Falls Free 9/82015
"7 19021974 Library to: Inlet Public Library, Town

of

When you open the hold request, the original pickup branch is selected in the Pickup drop-down list box,
and the new pickup branch is selected in the Rerouted to drop-down list box.

SARAHR ACOSTA © L REGISTRATION C'REFRESH

8 BLOCKS [ NOTES

& Check Qut (0) i Out (14) / Overdue (1) & Account (317.50) @ Claims (2)/ Lost (0) ™ Holds (6) More ~

More ~

Request ID Bib Control Number Activation

841512 72480 812672015 D Lot
Pickup Unclaimed Expiration

Hudson Falls Free Library ﬂ 9/82015 10/25/2015

Rerouted to
Inlet Public Library, Town of

When you check in an item that can fill a hold request for which the pickup location has been changed, the
Transfer for hold message box displays the new pickup branch. You can select YES to transfer the
checked-in item to the new pickup location, NO to check the item in but cancel the hold, or CANCEL to
cancel the check in.
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Transfer for hold

Barcode: 0002700008101
Title: The nonesuch.

This item fills a request at
Hadley-Luzerne Public Library (LUZ)

Transfer for hold?
(Click Cancel to stop the check-infcheck-out process.)

NO CANCEL
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You are here: Creating, Modifying, and Deleting Patron Records > Do a Quick Search for an Existing
Patron

Do a Quick Search for an Existing Patron

You can do a quick search by scanning a patron barcode or entering search criteria in the search box. Or,
you can use the Find Tool.

To do a quick search for an existing patron’s record:
1. Sign in to Polaris Leap.

The Circulation page opens with the cursor in the search box.

m XL NEW PATRON S PRINT

2. Do one of the following steps:

» Scan the patron’s barcode.

» Start entering search criteria in the box. As you type, automatic suggestions are displayed
that may include both patron and bibliographic records. If only one patron record matches the
entry, it opens immediately. You can choose a patron from the list of automatic suggestions or
press Enter or tap Go. If the search criteria match keywords in both patron and bibliographic
records, a total count is displayed for each type of record. Select Patron Keywords to open
the Find Tool. Select a patron in the Find Tool results list.

Please choose one of the following to narrow your
search for "ramachandran”

Bibliographic Keywords (6)

Patron Keywords (3)

The patron’s record opens to the patron's library account view. Select REGISTRATION to go to the
existing patron's registration view.

Note:
If the patron record requires updates, a message appears.

The pairon registration has expired. Please update.
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You are here: Checking Out and Renewing ltems
Checking Out Items to a Patron

When you open an existing patron’s record, Check Out is the active option in the toolbar and the cursor is
in the box where you can scan a barcode to check out an item. To renew an item already checked out to a
patron, go to the patron's items out list.

@ MAis Mlz ﬂ‘ 4 RECISTRATION { REFRESH CLOSE
=,
B BLOCKS

& & Cul W Oul Cwerchs (1 B Aocoun (¥ O Craiems 00 : - 1 Yol 1

| e Find Too ¥ Aunae-RFD & Special Loan

B RO CALL MUMBER TITLE HRE DATE ACTION SHELF LA THON ASSHAMED BHANCH WA TLRAL T7PL

If your library has enabled charging for checkouts and/or renewals in Polaris Administration, you can
manage these charges in Leap by paying, waiving, or charging the amount.

The permissions required to manage charges in Leap and the Polaris ILS are the same. For example, to
manage fines in Leap, the Fines: Pay fines at circ and Fines: Waive fines at circ permissions are
required.

If configured in Polaris Administration, a prompt appears in Leap when a charge has been enabled for the
item's assigned branch and that charge applies to: the action (check out or renewal); the item's material
type; and the patron code. The charges for check-out and renewals are set for the item's assigned branch
using the Check-out: Charge Options dialog box in Polaris Administration.

Note:
For more information on Polaris permissions and parameters, see the Polaris staff client Help.

If a patron is allowed to check out items held for an associated patron, you can scan the item's barcode
and check it out to the primary patron.

See also:

» Messages and Blocks During Check-Outs and Renewals
e Check Out Items

» Set a Special Due Date/Loan Period During Check Out

» Reset the Due Date/Loan Period

» Manage Charges for Check-outs/Renewals

» Resolve Charges for Renewal and Overdue Fine

o Check Out an Item Held for an Associated Patron

» Circulate Quick Circ ltems
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You are here: Viewing, Renewing, and Modifying ltems Out to a Patron
Viewing, Renewing, and Modifying ltems Out to a Patron

The patron’s items out list is displayed when you choose the Out (#)/Overdue (#) tab on the Patron
workform. The tab indicates the number of items out to the patron (in blue) and the number of overdue
items (in red). The Due On column displays the due date with an exclamation point if the item is overdue.
If the item can fill a hold request, a Yes appears in the Fills Hold column.

_n NASIR AZIZ © L REGISTRATION ™ REFRESH m

= |

B BLOCKS

REMEWALS FILLS
TYPE DLE Ol v BARCODE TITLE AUTHOR LEFT HOLD CALL NO. ERARCH

LLY BT D4 mnianizry Ma befors you Moyes Joj 2o 2 bl [ a5 v ity Librarg
E-cak GG

When you select an item in the list, you can perform the following actions if the button or option is
available: renew an item; set a special renew period; reset the due date; estimate fines; make a claim; or
declare the item lost.

Depending on the width of the application view, some action buttons may appear under the More menu
instead of in the button bar. You can also choose More to go to the patron's notification history view; check
in an item; or print the items out list.

See also:

+ Renew ltems from the Items Out List

» Reset the Due Date from the Items Out List

» Set a Special Renew Date or Loan Period from the Iltems Out List
» Estimate Fines from the Items Out List

e Claim an Item from the Items Out List

« Declare an ltem Lost from the ltems Out List

» View the Item Record from the ltems Out List

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.

111


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Renew_items_from_the_ite.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Set_a_due_date_from_the_items_out_list.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Set_a_special_renew_date.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Estimate_fines_from_the_.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Claim_an_item_from_the_i.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Declare_an_item_lost_fro.htm
https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/View_the_item_record_fro.htm

You are here: Viewing, Renewing, and Modifying Items Out to a Patron > Renew ltems from the Items Out
List

Renew ltems from the ltems Out List

To renew one or multiple items from the items out list:

1. Open the patron record.
2. Click the Out/Overdue tab.

The patron's items out list appears.
3. Select the item or items in the list and select RENEW.

The item is renewed if there are no conditions preventing its renewal, and the new due date is
displayed in the DUE ON column.

A message appears if the renewal exceeds the limit.

If the item is overdue, the Overdue Fine dialog box opens. From this dialog box, you can pay, waive,
charge the patron's account, or cancel.

If your library prints receipts for renewals, the print dialog box opens. See also: Setting Up Receipt
Printing for Leap.
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You are here: Checking Out ltems to a Patron > Reset a Due Date/Loan Period
Reset the Due Date/Loan Period

To reset the due date for an item:

1. Open the patron’s record, and select the items out view.
2. Select the item, and select Reset Due Date.

The calendar opens.
3. Select a new due date.

The due date is changed.
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You are here: Checking Out ltems to a Patron > Set a Special Due Date/Loan Period During Check Out

Set a Special Due Date/Loan Period During Check Out

To set a special due date or specify a special loan period when checking out items:

Note:

You can also select Settings under your username to specify a special loan period for all
items checked out during your logged-in session. See Leap User Interface.

Open the patron’s record.
The Check Out view is displayed.
1. Click SPECIAL LOAN.

The area below the button expands.

NASIR AZIZ @

|E|_ i BLOCKS

- A K Out i Cut werdue (1 I A int (3 (= Claim:
e i i A F

a September 2017 [+] Loan pefiod:

Su Mo Tu We Th Fr Sa

2. Set the special due date using one of these methods:

» Select a date using the calendar control.

& REGISTRATION

o |

ACTIONS -

G Special Loan

y bo neodt itesm anly

v to all tems for this patron

CAMNCEL

» Type a number in the Loan period box, and select Days, Hours, or Minutes in the drop-

down list box.

3. To use this special loan period for the next item checked out to this patron, select Apply to next

item only.

4. To use this special loan period for all items you check out to this patron during this session, select

Apply to all items for this patron.
5. Select OK.
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You are here: Viewing, Renewing, and Modifying ltems Out to a Patron > Set a Special Renew Date or
Duration from the Items Out List

Set a Special Renew Date or Loan Period from the ltems Out
List

To set a special renew date or renewal loan period:
1. Open the patron record.
2. Click the Out/Overdue tab.
The patron's items out list appears.
3. Select an item in the list, and select the special renew button.

The area below the button bar expands.

L] June 2016 LH Loan period: | 7 WE W

S Mo Tu Wa Th Fr Sa Hpph 1o neot bem only

Apphy tn all e for this paimn

CANCEL

4. Do one of these steps to set the special renewal:

» Select a specific due date from the calendar.
» Specify a loan period other than the default setting of 7 Days by typing a different number in
the Loan period box and selecting Days, Hours, or Minutes from the drop-down list box.
5. (Optional) If you want the loan period to apply to other items for this patron, select Apply to next
item only or Apply to all items for this patron.
6. Click SPECIAL RENEW.

The item is renewed for the period specified.
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You are here: Checking Out Items to a Patron > Messages and Blocks During Check Outs and Renewals
Messages and Blocks During Check-Outs and Renewals

As you check out items in Leap, messages or blocks may appear due to the status of the item or the
patron. For example, the item may be in-transit, or the patron may owe fines.

Patron is blocked

Do you want to continue with this operation?

Patron owes money. Amount due: $10.00

Patron has exceeded maximum fees permitted. Amount due: $10.00

Patron has unread messages

If a message or block appears in Leap, you can select CONTINUE (if you have the appropriate
permissions) or CANCEL.

These messages and blocks appear in Leap according to the same criteria that they appear in the Polaris
staff client. For more information on the types of messages and blocks that may appear when checking
out items in Leap, see the topic Check-Out Blocks and Messages in Polaris ILS Help.
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You are here: Checking Out ltems to a Patron > Check Out an Item Held for an Associated Patron

Check Out an Item Held for an Associated Patron

If the primary patron is allowed to pick up held items for an associated patron, the primary patron can pick

up and check out held items for the associated patron.
To check out items to a primary patron when the items are on hold

1. Open the primary patron's record.
2. Select CHECK OUT.
3. Scan the held item's barcode.

for an associated patron:

The item is checked out to the primary patron and the history view is updated for the item and the

hold request.

In the ACTION column of the item record's history view, the text,Checked out by associated patron, is

displayed.

{ Circulation = Controls B Blocks and Notes ~ #D HIEiDI\"E

/LOCATION

2M17/2015 12:04.49 PM  Schenectady Branch - Central  In -> Out [Checked out by associated patron ] Community Library

DATE ASSIGNED BRANCH STATUS ACTION

11/25/2013 3:44:29 PM  Schenectady Branch - Central  In Created via Circulation

Schenectady Branch - Central ~ Phelps/Phelps-W§

USER/WKS PATRONID

laura.peer/Peer-Wg 208972

In the ACTION column of the request history, the text Request satisfied by associated patron is

displayed.

* Request History

DATE STATUS BARCODE BRANCH USER

ACTION

/

2011712015 Out to patron  test112513 Schenectady Branch - Central laura. peer [

Request satisfied by associated patron ]
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You are here: Modifying User Settings > Set Check In Workform User Default
Set Workform User Defaults

To specify your preferred opening view for the Check in or Item Record workform:

Note:
Your library can also set an opening view for the Leap ltem Record workform using the Polaris
Administration Staff Client profile Web App: Default view selected when item record opened.

1. Select your username, and choose Settings.
The Settings page opens.
2. Select the Workform User Defaults tab.

Settings (" REFRESH m

B Brint Cetian o= . [E] wiork er Defau R

i T R 5

3. Select one of the radio buttons below Check in to specify the opening view of the Check In workform, or
select one of the radio buttons below Item record to specify the opening view of the Item Record
workform.
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You are here: Checking In ltems and Managing Fines > Check in Items in Normal mode
Check In Items in Normal mode

To check in items in Normal mode:

Note:
To use the bulk check-in mode in Leap, see Check in ltems in Bulk Mode.

1. Click CHECK IN.
The Check In page opens with the cursor in the barcode box.
2. If the view is set to another mode, choose Normal.

3. (Optional) To change the number of free days, type the number in the Free Days box. The date
changes accordingly.

4. Scan the item barcodes. Or, if you are using Leap on a library workstation for which RFID has been
enabled, you can place items on the pad, and choose the return button to read the tag and check
the items in. If RFID has been enabled, the return button displays the RFID icon.

Note:
You can also choose FIND TOOL and search for an item to check in. See Check In from the
ltem Record .

The items are checked in. If you want to print a check-in receipt, see Print Check-in Receipts.
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You are here: Checking In ltems and Managing Fines > Check in ltems in Bulk mode

Check in Items in Bulk Mode

You can quickly check in multiple items in bulk mode. With bulk check-in, most blocks and dialog boxes do
not appear. Users who have selected the bulk view as the default check-in view in Leap or in the Polaris
staff client will automatically go to the bulk view when checking in items using Leap.

The default view for the Leap Check In workform can be set in Leap on the Workform User Defaults view
of the Settings page. See Set Workform User Defaults.

In the Polaris staff client, the default view is set using the View menu on the Check In workform.

If the user's default is set to In House or Inventory mode in the staff client, the Leap Check In workform
opens in the Normal view.

The Leap Bulk Check In view uses the same display settings as the Bulk Check In mode in the Polaris
staff client. The displayed columns are determined by the settings in the Check in list view options
parameter in Polaris Administration. For more information on bulk check in, see the Polaris staff client
online Help.

To check in items in bulk using Leap:
1. Select CHECK IN.
The Check In page opens in the default check-in mode setting.
2. If the Normal check-in mode is displayed, choose Bulk to change to the Bulk check-in mode.

3. If you want to change the free days, enter the number of days in the Free Days box or choose a
date from the calendar. Free days are set according to the Free days (bulk)Patron Services
parameter in Polaris Administration.

4. Scan the item barcodes to check the items in.

As items are checked in, they display at the top of the list, the status in the Status column indicates
the status change: from > to. For example: Out > In.

The item barcode, due date, status, comments, and fine charged to the borrowing patron, if
applicable, appear in columns in the list of items checked in. Your library may also choose to display
the item’s title, material type, and/or the borrower’s name. The Comment column displays conditions
such as Quick circ item for a Quick Circ item or To Branch name for an item that is in-transit.

5. Continue to scan item barcodes until you have checked in all the items.

When an item is checked in, a transaction is logged with the type: Checkin Leap Bulk.

Bulk Check-in - Messages and prompts

When you check in items using bulk check in, you may encounter messages, dialog boxes, or prompts for
the following types of items:

» Items belonging to other branches

If you scan an item that does not belong to your branch, a prompt displays if the Patron Services
parameter Check-in: Prompt for in-transit in bulk mode is set to Yes. If the parameter is set to
No, items that belong to other branches are set to In-transit without a prompt. When the item is

checked in, the Status column displays In-Transit and the Comment column displays To Branch
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name. If you set Polaris for in-transit slip printing at the Check In workform, an in-transit slip is
printed.

Items that have been billed

If the patron has been billed for an item, the Resolve billed item dialog box appears. Select an
action for each billed amount and choose CONTINUE.

Items with blocks

If an item has a free-text or manually-assigned block, a dialog box displays the text and offers the
option to check in or cancel.

Items that satisfy hold requests

When you scan an item that will fill a hold request where the pickup branch is also the check-in
branch, the item is trapped for the request, and the status becomes Held. The Comment field
displays “For [patron name]”. If the pickup branch is a different branch, the item status becomes
Transferred to pickup branch, and the Comment field displays “To [branch]”

If the item is already held, the item status changes to In, In-transit, or Held for the next patron. The
Comment field displays the action taken.

Items from other library systems (ILL items)

If you check in an ILL item from another library system, a message indicates the item is an ILL and
prompts you to continue or stop the check in. If you continue with the check in, the ILL item will be
processed in the same way as in the Polaris staff client.

Quick Circ items
If you check in a quick circ item in bulk mode, the Comment column displays Quick-circ item.
Claimed items

If you check in an item with a Claimed status, the status column displays Claim Returned, Claim
Never Had, or Claim Missing Part.

Items in floating collections

When you check in items in the bulk view, items float (or not) according to the library's policy. If the
option "Prompt for additional floating items" is set to yes for the check-in branch, the prompt
displays. The floating limits set in Polaris administration are respected.

Items with fines

If items that you are checking in have fines, they are charged to the patrons’ accounts automatically
as the items are checked in and no messaging displays. The amount is displayed in the Fine
Charged column.
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You are here: Checking In Items and Managing Fines
Checking In Items and Managing Fines

The Check In workform opens to the view selected in your user settings in Leap or the Check-In workform
setting in the Polaris staff client (Check-In workform | View | Save Current View as Default View). The
columns displayed on the Leap Check In page are determined by the settings in the Check in list view
options parameter in Polaris Administration. For more information, see Polaris online Help.

Check In CLOSE

&M o 11 Hiise o v

e FIND TOOL | Auma-RFID 22113 P—

BASRCOOE  DUE DATE  STATUS  COMMESMT  TITLE  MATERIAL TYPE  SHELF LOCATION  CALL HUMBER  PATROM HAME  ASSIGHED BRANCH  COLLECTION

When you check in items, messages may appear for items that are overdue and have a fine; items for
which holds have been placed; or items that have other blocks. If you have the appropriate permissions,
you can resolve fines and fees from the Check In page.

As you check in items, the count of checked-in items is updated.
If your library is set up to print check-in receipts, you can print receipts either in Normal or Bulk mode.
See also:

e Check In Items in Normal mode

e Check in Items in Bulk Mode

» Check In Items in In House mode

e Check In Items in Inventory Mode

» Check In from the Item Record

» Manage Fines During Check In

» Resolve Billed Items During Check In

» Change Item Information or Barcode During Check-In
» Print Check-in Receipts
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You are here: Checking In ltems and Managing Fines > Check in from the Item Record
Check In from the Iltem Record

To check in an item from the Item Record workform:

1. Open the item in the Item Record workform.
2. Select ACTIONS | Check In.

A message box informs you the item will be checked in.
3. Click CONTINUE to continue checking in the item.

Note:
Leap uses the same checks for permissions and blocking conditions as are used in the
Polaris staff client.
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You are here: Notices
Viewing Patron Notices and Associated Items

The Notices view of the patron record displays the patron’s notification history with the following
information for each notice: title, type of notice, date, method, and amount. You can filter the notices, view
the notification history, and view the associated item record. To open the Notices view of the patron record,
select More | Notices.

& | MR. EUGENE J MUJICA © LREGISTRATION  (CREFRESH 03
=
@ BLOCKS
o Check Out i Out (257 Overdue (29 6 Account (537,44 = Clalme (1) F Lost {1 ™ Holds (5] Held (I Molices =
%) Rpading History
TITLE TYPE DATE & ME THOD W Meszages
Tha graat airport mystery E IRO16 Print il Blocks
Firafligs B WIRRO1G it =] Mobe
See also:

+ View an Item’s Notification History
» Open the ltem Record Associated with a Notice
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You are here: Viewing Patron Notices and Associated ltems > Open the ltem Record Associated with a

Notice

Open the Item Record Associated with a Notice

To open the item record associated with a patron notice:

1. Open the patron’s record.
2. Select More | Notices.

The patron’s notification history is displayed.

3. Select a notice in the list.

The Notification History for the item is displayed.

Notification History

Title: Breath, eyes, memory [large print]
Material Type: Book

NOTICE METHOD DATE FROM  AMOUNT

ITEM RECORD

STATUS
Almost overdue/Auto-renew reminder Email 91612014 coB Email Completed

1st Overdue Email 91212014 coB Email Completed

4. Select ITEM RECORD.

The Item record opens.

Polaris Version 5.6
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You are here: Claimed and Lost Iltems

Viewing and Modifying a Patron's Claimed and Lost Iltems

If the patron has claimed items or declared items lost, the items are listed in the patron's record when you
select Claims/Lost. The first number indicates the number of claimed items and the second number
indicates the number of items that were declared lost.

From the Claims/Lost list, you can: reset the patron's total claim count; estimate fines (if your library has
opted to include claimed items in estimated fines); and view the notification history for a claim.

| 2 | MR. EUGENE J MUJICA © srecistranion | crerresH ) [EEES
e
B BLOCKS
ol Chech Ot (0 W Ot () Creendus (2 B Account (537 484 S Clalms (1 51 01 M Hods (5 Hedd o0 o =
) Resat Claim Count g Estimate Fines
Todal Claims: Currem Claims: 1 Lost: 1
BARCODE TIMLE CLAIM D&TE DESCRIPTION DUE DATE
DOO1S002 45054 Thees gresat aport spstang BAZDIE Claim Radumsd BR2015
GO00X0A0TELEY  Uncalaloged Bems - Pedodicals - Saraboga Spiings Public Librafy BNA2018 LostUnpaid 22008
See also:

» View Estimated Fines for Claimed and Lost Items
» View Notices for Claimed or Lost ltems

» Reset the Claim Count

» Change a Claimed Item to a Status of Lost
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You are here: Viewing, Renewing, and Modifying Items Out to a Patron > Claim an Item from the ltems
Out List

Claim an Item from the Items Out List

When an item is listed as checked out to the patron, but the patron claims she never checked out the item
or has already returned it, you can assign a claim status to the item.

To assign a claimed status to an item in the patron’s item list:

1

2.

. Open the patron record.
Click the Out/Overdue tab.

The patron's items out list appears.

. Select the check box in the column to the left of the item that you want to claim, and select Make a
Claim.

The area below the button bar expands.

Chooss g claim ststus 3im Rehaned | CANCEL

. Select the claim status, and click CLAIM.

The item is claimed and appears on the Claims view of the Patron Record.
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You are here: Viewing and Modifying a Patron's Claimed and Lost Items > Change Claimed Items to a
Status of Lost

Change a Claimed Item to a Status of Lost

You can change a claimed item to a status of Lost from the Claimed/Lost view of the patron's record.

To change a claimed item (Claim Never Had, Claim Returned/Accruing, Claim Missing Part) to a status of
Lost:

1. Open the patron's record.
2. Go to the Claims/Lost list.

3. Select a claimed item in the list.
4. Select the Declare Lost button.

The Declare Lost dialog box opens.

Declare lost item

Item Barcode: 0000900371113 Title: The golden compass!

Due Date: 10/6/2016 Billed Date: Billed

Patron Name: Test Abbou, Sienna Patron Barcode: 21234000010009 Total Fine: $25.02
Replacement: Processing Overdue:

Charge: $20.00 $5.02 $0.00

Paid $0.00 $0.00 $0.00

Waived: $0.00 $0.00 $0.00

Amount due: $20.00 $5.02 $0.00

Action: Pay - Waive £ Leaveasis ¥

Amount $20.00 $5.02 $0.00

Payment method: Payment amount: $20.00

Cash v

o

5. Specify the action to take for each charge.
6. Select OK.

Depending on your selections in the dialog box, the Claims/Lost view displays the description
Lost/Unpaid or Lost/Accruing.
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You are here: Viewing, Renewing, and Modifying Items Out to a Patron > Declare an ltem Lost from the
Items Out List

Declare an ltem Lost from the Items Out List

To declare an item lost:

1. Open a patron record.
2. Click the Out/Overdue tab.

The patron's items out list appears.

3. Select the check box in the column to the left of the item that you want to declare lost, and choose
the Declare Lost button.

The Declare lost item dialog box opens.

Declare lost itern

e OEMATTING the: The goldes compass!

e THEZIE Blilked Dai Eilled

Harme Tast Ahbou, 5iesesa aron Baceds #17 H0000AS005 Total Fine 574500
520.03
$0.30
§0.80
520.03

4. For each charge type, select the appropriate action in the Actions box.
5. Select the method of payment in the Payment method box.

Note:
Integrated credit card payments are not available in this version of Leap.
6. Click OK.
Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.
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You are here: Viewing and Modifying a Patron's Claimed and Lost Items > View Notices for Claimed or
Lost Items

View Notices for Claimed or Lost Items

To view the notification history for a claimed or lost item:

1. Open the patron's record.
2. Select Claims/Lost to open the list of claimed or lost items.
3. Select the check box next to the item, and select the notification history button.

The notification history for the claimed or lost item is displayed.

Notification History

Title: The theatre of Tennessee Williams
Material Type: Book

NOTICE METHOD DATE FROM AMOUNT STATUS
1st Overdue Email 8/29/2014 CoB Email Completed
ITEM RECORD CLOSE

4. To see the claimed or lost item record, select ITEM RECORD.

The item record is displayed.
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You are here: Viewing and Managing a Patron's Financial Account

Viewing and Managing a Patron's Financial Account

To view the patron's financial account with your library, open the patron record, and select Account. The
patron's Account Summary list appears. To change the view, select Collection Agency or Transaction

Summary.
ANAR KAMAT © L AEGISTRATION € REFRESH CLOSE
i BLOCKS
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W Add Charge B Create Cradit
Charges: 520,40 Doposits; 5000 Credits: 50,00 Batsnce: 52940 Aercoanl Surrrmaty -
TYPE DATE BARCTDOE TITLE REAROH ORGANIZATION MOTE BILLED Collaclion Agency
saclioe SurTrian
Charge - MMERZ016 | 0001000042910 | The naw diary -howty | OCvarduaitem | Community Library  Bilied vt Trangaction Sunmvary
59 & joumat for seif replacemand
uidance and charge
pahided craalvity
Charge 2016 Replacamsnt | Community Liorary - Biksd Wog 52200 522.00
Cost
Crarge - TIA2015 | ODOOMII3ETAST | Gone pirl [sound Check Cut Schenaclady 51.00 51.00
recordng Charge Branch - Cenfral
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recnrding]
3204

The columns in the Account list display the type of charge, credit, or deposit; the date; the item barcode
and title (if applicable); the reason for the charge, credit or deposit; the organization that made the
financial transaction; notes (if entered); and the amount. When you choose a specific line in the Account
list, the applicable task buttons are active. For example, when you choose a credit, the refund credit

button is active.
See also:

» Add a Charge to a Patron's Account

» Pay Patron Charges

+ Waive Patron Charges

» Add a Credit to a Patron’s Account

» View a Patron’s Collection Summary

» Remove a Patron Account from Collections

» View a Patron’s Transactions, Refund or Credit Payments, and Reprint Receipts

e Secure and Release Patron Records

Polaris Version 5.6
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You are here: Viewing and Managing a Patron's Financial Account > Add a Charge
Add a Charge to a Patron's Account

To add a charge to a patron's account:

1. Open the patron's record.
2. Click Account to go to the account view.

3. Click Add Charge.

The area below the button toolbar expands.
W Addd Change B9 Crvabe Crodt Mo -

Arrount I

Foa Hamsmn Saiert oo W

et Ber ol

FIND TOOL

Hotes
CAMNCEL

4. Type the amount of the charge in the Amount box.

5. Select the reason for the charge in the Fee Reason box.
6. Do one of the following steps:

« If the charge is related to an item, scan or type the barcode in the box.

« If the item is not in hand, click FIND TOOL to open the Find Tool, search for the item and
select it.

7. To enter notes regarding this charge, type them in the Notesbox.
8. Click ADD CHARGEDbutton at the bottom of the dialog box to add the charge.

The charge is added to the patron’s account.
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You are here: Viewing and Managing a Patron's Financial Account > Pay Charges
Pay Patron Charges

To select charges and pay them:

. Open the patron's record.
. Select Account in the summary toolbar to go to Account view.

1
2
3. Select the check box next to the charge or charges you want to pay.
4. Select PAY.

The area below the button expands.

m 9 \Waive Charge W Add Charge E Create Credit More -

Balance: $6.60

Amount

$6.60 X

Method:
Cash V]

Mote:
KA o

. If the amount paid is different from that displayed in the Amount box, type the amount.
. Select a payment method in the Method box.

. (Optional) Type a note in the Note box.

. Select PAY.

0 N O O

The charges are paid, and the patron’s account is updated.
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You are here: Viewing and Managing a Patron's Financial Account > Waive Charges

Waive Patron Charges

To waive a charge or charges, and distribute waived amounts:
1. Open the patron's record and select Account to go to the account view.

The Account view displays the account summary at the top of the list with totals for Charges,
Deposits, Credits, and the total balance on the account.

2. Select the check box next to the charge (or charges) you want to waive.
3. Select the Waive Charge button.

The area below the toolbar buttons expands.

Balance: 3010

Amount to waive: o 10 x

Note:

4. (Optional) Enter a note regarding the waived amount.
5. Select WAIVE to waive the amount displayed, or:
« Enter an amount less than the total amount of the charge, enter it in the Amount to waive
box, and select WAIVE.

« If you selected multiple charges and want the waived amount to be distributed among the
selected charges, select Distributed waive, enter an amount in the Amount to waive box,
and select WAIVE.

A message indicates the charge was waived successfully.
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You are here: Viewing and Managing a Patron's Financial Account > Add a Credit to a Patron’s Account
Add a Credit to a Patron’s Account

To add a credit to a patron’s account:

1. Open the patron's record.
2. Click Account.

The Account list appears with totals at the top of the list for Charges, Deposits, Credits, and the total
balance on the account.

3. Click Create Credit.

The area below the button toolbar expands.

% Add Charge B Create Credit More -

Credit to add: 50.00

Method: Cash [~

-

4. Enter the amount in the Credit to add box.
5. Select the payment method in the Method box.

Note:
Integrated credit card payments are not available in this Leap version.

6. To enter an optional note, type it in the Note box.
7. Click ADD to add the credit amount to the patron’s account.
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You are here: Viewing and Managing a Patron's Financial Account > View a Patron’s Transaction
Summary

View a Patron’s Transactions, Refund or Credit Payments, and
Reprint Receipts

You can view patron account transactions, go to the item record associated with the transaction, or print
past receipts from the Transaction Summary view.

To view the patron’s account transactions and reprint receipts:

1. Open the patron record.
2. Select Account.

The Account Summary view appears.
3. Select View |Transaction Summary.
The Transaction Summary view displays the patron's transaction history.

Note:
You can select an item in the list to display the item details view.

4. Do one of the following:

« Select a payment transaction, and select Credit to credit the patron's account.
» Select a payment transaction, and select Refund to refund the payment.
» Select one or more transactions, and select Print List to reprint the receipts.
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You are here: Viewing, Renewing, and Modifying ltems Out to a Patron > Estimate Fines from the ltems
Out List

Estimate Fines from the Items Out List

To estimate fines for items in the items out view:

1. Open the patron record.
2. Click the Out/Overdue tab.

The patron's items out list appears.
3. Select the item or items in the items out list, and choose Estimate Fines.

The estimated fines appear.

Note:
The Estimated Fines dialog box displays the amount owed for all items, not just the selected
items.

Estimate nes

WEM

TITLE ALTHOR STATUS - [DHIE NATE FME

Diniry ared The dirarsaur [sound recending] Heff, Spd, TH92-204.  Loat 1A2EH5 £5.00

Ther e and fulure king Whie, T. M. [Teeence Losl 10 LR
Hanbury], V5061564

Thes fved s ey reid - b novwed Shiwar Anis Lol RS 40

Ther marroee read o the deap nork Flanagan, Richard o3t A £5.80
1561 - authoe

Extimaad First Totn §20.00

CLOEE

4. To change the due date, choose SELECT DATE, and select a different date from the calendar.
5. Select CLOSE to close the dialog box and return to the items out list.
Note:

If your library has opted to include lost and/or claimed items in the estimated fines calculation,
you can also estimate fines from the Claims/Lost view.
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You are here: Checking Out Items to a Patron > Resolve Charges for Renewal and Overdue Fines

Resolve Charges for Renewal and Overdue Fine

If your library charges for renewals and prompts for the renewal charge, a single dialog box appears when
you renew an item for which overdue fines are owed. You can then resolve both the renewal charge an the
overdue charge in one step. The options to charge for renewals and prompt for the charge are set using
the Check-Out: Charge Options Patron Services parameter in Polaris Administration.

Note:

If your library charges for renewals but has not selected the Prompt in the Staff Client check
box on the Check-Out: Charge Options dialog box, the overdue fine dialog box appears and
the renewal amount is applied to the patron's account.

To resolve charges for a renewal and overdue fines:
1. Renew the item.
The Renew chargeable overdue item dialog box appears.

2. For the Checkout (renewal) charge and the Overdue Fine, select an action in the Action box.
3. Enter an amount for each charge in the Amount box.
4. Select the payment type in the Payment method box.

Example:

Select Pay from the Actions drop-down list for each charge and enter an amount equal to or
less than the charge in the Amount box.

Note:
If you enter an amount less than the total charge, the amount is added to the patron's
account.

5. Click CONTINUE.

If you selected Pay in the Actions drop-down list, the payment is recorded in the patron's account,
and a receipt is printed. The receipt includes the Checkout Charge/Overdue in the Reason field,
the total charges, the total amount paid, and the patron's remaining account balance..

Polaris Version 5.6 © 2017 Innovative Interfaces, Inc.

148


https://help.polarislibrary.com/leap(v5.6.edge)/Content/LEAP1_0/Checking_Out_and_Renewing.htm

You are here: Checking Out ltems to a Patron > Manage Charges for Check-Outs/Renewals

Manage Charges for Check-outs/Renewals

To manage charges for check-outs and renewals in Leap:

Note:

If your library charges for renewals, and you are renewing an item for which overdue fines are
charged, you can resolve both the renewal charge and the overdue fine.

1. Check-out or renew an item for which a charge has been assigned for check-out/renewal in Polaris

Administration.

The Patron Check-out Charge or Patron Renewal Charge dialog box opens where you can manage

the charge.

Patron Check-out Charge
There is a charge to check out this item.

- 123456789

The tiger's wife - a novel
A12291954

Ms. Laura lzquierda

$1.00

PAY...

WAIVE

CHARGE ACCOUNT CANCEL

2. If you want to change the amount that is paid, waived, or charged, modify the amount in the Charge

box.

3. Click one of the following buttons:

« PAY - The area below the charge expands. If the amount paid is different than the amount
charged, you can enter it in the Amount box. Select the payment method in the Method box.

Then, click PAY.

Patron Check-out Charge
There is a charge to check out this item.

Balance $1.00
Amount $1.00
Method Cash

Note

KA o

« WAIVE - The charge is waived and the item is checked out.
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« CHARGE ACCOUNT - the charge is added to the patron's account, and the item is
checked out.
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You are here: Checking In ltems and Managing Fines > Manage Fines During Check-In
Manage Fines During Check In

To check in multiple items and manage fines:
1. Log into Leap, and choose CHECK IN.

The Check In page opens with the cursor in the barcode box.

Utilifies. = Help = laura. peer (COB) ~

Check In CLOSE
| o FIND TOOL Free Days: 0 5/15/2015 CLEAR LIST

BARCODE DUEDATE STATUS COMMENT TITLE MATERIAL TYPE SHELF LOCATION CALLNUMBER PATRON NAME ASSIGNED BRANCH

2. Scan each item's barcode.

If the patron has been billed, the Resolve billed item dialog box opens. See Resolve Billed ltems
During Check In.

If the item is overdue, the Overdue Fine dialog box opens. You can resolve the overdue fines
immediately or choose CONTINUE to continue checking in items.

If you choose CONTINUE on the Overdue Fine dialog box, the box closes and you can continue to
check in items. Fines will be totaled for each patron, and you can resolve the charges after checking
in all the items.

3. To view and resolve the fines, choose RESOLVE CHARGES.

The patrons for whom the checked-in items included fines are listed at the bottom of the Check In
page with totals for new fines and old fines.
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Check In

Scan or en 44 FIND TOOL Fres Days [ - RESOLVE CHARGES CLEARLIST
DUE MATERIAL SHELF CALL PATRON
BARCODE DATE STATUS COMMENT TITLE TYPE LOCATION NUMBER NAME ASSIGNED BRANCH
0000101432037 4M32015  Out->In-Transit To Lake Pleasant Public Under the Tuscan sun : [sound Audiobook RC 91455 Mr. Mark M Lake Pleasant Public
Library, Town of recording] st hame in ltsly May Swots Library, Town of
38876000002319 4162015 Out > In-Transit To Mary Cay's Branch The art of calligrephy: a practical Book 7456 Al Mrs. Connie Schenectady Branch -
guide Colson Central
0004400167200 5/260/2016  Out = In-Transit To Frothingham Free Library  Wiater for elephants [large print] Book LT Fict ru Miss Racheel A Frothinghsm Free Library
{Fonds) Gaal (Fonda)
0001000035103 T/23/215  Out->In-Transit To Cangjoharie Library One hundred years of solitude Book Fict Gar Anar Kamat ‘Canajoharie Library
3364100100000751 In-Transit-> In-  To Southem Adirondack The Vietnsmese gulag Book 950.7040 ‘Southam Adirondack
Transit Library System Library System
0000100363505 In-Transit-> In-  To Schenectady Branch - Stars Book J523.8 Galwsy Public Library
Transit Central
Hide
PATRON NAME BARCODE NEW FINES 'OLD FINES A
O Mr. Mark M Swota 1000201342622 $3.30 $0.00
O Mrs. Connie Colson 1000401538316 §6.00 3290
[m} Miss Rachael A Gasl 1000402454762 §204 36.60 v
% Pay New W waive New % Charge New & Manage All Fines Hide
PATRON NAME BARCODE NEW FINES OLD FINES ~
E Mr. Mark M Swots 1000201342622 $3.30 $0.00
D Mrs. Connie Colson 1000401538316 $5.00 $12.00
O Miss Rachsel A Gaal 1000402454762 $2.04 $6.60 v

5. Select the appropriate action button. If you choose Manage all Fines, you can go to the patron's
account and manage all the patron's charges. See Viewing and Managing a Patron's Financial
Account .
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You are here: Checking In ltems and Managing Fines > Resolve Billed ltems During Check-In

Resolve Billed Iltems During Check In

When you check in an item returned by a patron who has billed fines and/or fees, you can resolve the
billed item.

To resolve a billed item during check in:
1. Log into Leap, and select CHECK IN.
The Check In page opens with the cursor in the barcode box.
2. Scan the item barcode, or search for and select the item.

If the patron has been billed for amounts owed to the library, the Resolve billed item dialog box

opens.

Resolve billed item
ltern Barcode: 0000602255028 Title: The Emperor's new clothes [DVD]
Due Date: 8/23/2013 Billed Date: 9/10/2013 +| Billed
Patron Name: Mr. George P Anderson Patron Barcode: 1000600712177

Replacement: Processing: Overdue:
Charge: $29.99 $0.00 $5.00
Paid: $29.99 $0.00 $0.00
Waived: $0.00 $0.00 $0.00
Amount due: $0.00 $0.00 $5.00
Amount:

$29.99 $0.00 $5.00

Actions: v] Leave as is[w| v]
Payment Cash ﬂ Total Fine: $34.99
method:

Under each column, a drop-down list box contains options for performing actions applicable to the
charge type.

3. To resolve a charge during check in, select one of the following options in the Action box:
« Waive
» Leave as is
+ Pay
« Charge

4. Select CONTINUE to check in the item and perform the selected action on the charges.
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You are here: Using the Holds Picklist
Using the Holds Picklist

When you open the Picklist, the Pending requests are listed for the branch you selected when logging into
Leap. You can choose a different branch from the drop-down list box at the top of the Picklist. To view
holds with other statuses, select another tab. The totals are displayed for each view for the selected
branch, and these totals are updated as the hold requests change statuses.

Note:
If a hold request is for a serial, the call number includes the volume and copy, and the title
includes the serial title and designation.

For information on INN-Reach requests, see Circulate ltems Requested via INN-Reach.
You can take a tablet into the library stacks, and do the following for selected hold requests in the Picklist:

 Indicate the item was located
« Indicate an item was not claimed (picked up)

» Set a hold request to "Ask me later" - This removes the hold request from the pending list, and
moves it to the next step in the Request to Fill (RTF) process.

» Deny a hold request

» View the held items that need to be transferred to another pickup branch
» Open the Hold Request workform

 Link to the item record

 Link to the patron record

To open the holds Picklist, choose Utilities | Picklist Processing.

Holds Queue

Picklist Processing

Create Unlinked Bibliographic Record Set
Create Unlinked Authority Record Set
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Picklist ta an 1 * ™ REFRESH m

L 1¥] i 1 i L]

MAaTERIA PICHELR FENLHRG
I W & SHELF LOCATION CA MUMBER AUTHOR [l TTPE BRARCH BaRCOOE WATE

hildran's Fiction | Fict Pottar Beatris The take of Jemima ok P Ariarain

» Select a hold request and choose Properties to open the Properties dialog box.

O Properties

The Hold Properties dialog box displays the following information on the Hold Request, Item, and
About tabbed views:

o Hold Request view:

= Hold Status

= Status Date

= Activation Date

= Expiration Date

= Patron - The patron name is a link to the patron record.
» Registered At

» Pickup Branch

o ltem view:

» Title

= Barcode - The barcode is a link to the item record.
= Assigned Branch

= Material Type

= Routing Sequence

« About view:

= Request ID
= Created by

= Date created
= Modified by
» Date modified

The Picklist has the following views:
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» Pending - Click the Pending tab to list the hold requests with a Pending status for the
selected branch.

« Located - Click the Located tab to list the holds that have been set to Located for the
selected branch.

« Unclaimed - Click the Unclaimed tab to list the holds with an Unclaimed status for the
selected branch.

» Unclaimed ILL - Click the Unclaimed ILL tab to list the ILL requests for the selected
pickup branch that have a status of received-held and an unclaimed date earlier than
the current date. You can click a row in this view to open the ILL Request workform.

« Holds to Transfer - Choose the Holds to Transfer tab to list the held items that need
to be transferred to a changed pickup branch.

To perform an action on hold requests in the Picklist, select the check box to the left of each hold request
you want to change. When a hold request is selected, the applicable action buttons are activated. To
select all the requests, choose the check box in the column header.

To modify the circulation status from the Picklist, you must have the Picklist application: Modify
circulation status permission set in Polaris Administration.

159



Then, choose an action button to change the pending hold request.

Note:
The REFRESH button refreshes the list.

Indicates that the item has been selected and is on the way to a processing
™ | ocated location where it will become held for the patron or go in-transit. The
pending request moves to the Located list, which you can view by selecting
Located at the top of the page.

The hold request is removed from the pending list, and it moves to the next

@ Ask Me Later i .
step in the Request to Fill (RTF) process.
, Missi The item is set to Missing. When an item is declared missing from the
I55ing Picklist in Leap, the item history is updated with the following: Circulation

status modified via Picklist processing.

The hold request is denied, and it is removed from the pending list.

[E=a ]
Opens the Hold Properties box that contains information about the hold

© Properties request and links to the patron and item records.
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See also:
» Sort and Filter the Picklist
+ Indicate an ltem Was Located
» Mark a Hold Request with Ask Me Later

» Return a Located ltem to the Pending List
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You are here: Using the Holds Picklist > Sort and Filter the Picklist
Sort and Filter the Picklist

You can do the following to sort or filter the Picklist:

» Select a branch from the drop-down list at the top of the Picklist.
» Click a column header to sort the list.

» Start typing in the Filter requests box. For example, start typing the call number to locate all items in
the same library location.
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You are here: Using the Holds Picklist > Indicate an Item Was Located
Indicate an Item Was Located

To mark items as located in the picklist:
1. Open the picklist.

Your login branch is the default branch displayed. You can choose a different branch by selecting it
in the drop-down list box.
Tip:
To filter the hold requests by a category, such as a collection, that corresponds with the
location of items in the library, start typing the filter term in the Filter requestsbox.
2. Locate the items on the shelves that match the hold requests in the list.
3. Select the check box next to each found item in the picklist.
4. Select Located.

The following occurs for each hold request marked as Located:

» The hold request status changes to Located
» The item status remains In
« The request moves from the Pending list to the Located list.

After marking the requested items in the picklist as Located, you can take the located items to the
pickup location where they can be scanned at a Polaris workstation where they become “held.” Al
other holds processing and notices function according to established methods in the Polaris staff
client.
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